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 Manual Configuration
The following manuals are included with the product.

 z Residual Risk

This manual describes the map of residual risks that require protective measures by users.

 z Setup Guide

This manual describes how to connect the printer to a computer and set it up following installation.

 z User’s Guide (This Manual)

This manual describes details about product functions and operations.

 z Maintenance Guide

This manual describes how to replace consumables, and how to clean and maintain the product.

The latest versions of the manuals can be downloaded at the website.

https://www.oki.com/printing/
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 Reading the Manual

Symbols

Note

 z These are cautions and restrictions for the correct operation of the device. Make sure to read to avoid misoperation.

Memo

 z These are references and information that are useful when using the device. We recommend reading them.

Reference

 z These are the reference pages. Read to learn detailed information and relevant information.

WARNING
 z Mishandling due to ignoring this display may cause death or serious injury.

CAUTION
 z Mishandling due to ignoring this display may cause personal injury.

Keys, Buttons, and Symbols
This chapter describes the following keys, buttons, and symbols.

Inscription Description

< > button/key

 z Indicates hardware buttons and the numeric keypad on the control 
panel. 
E.g.:

  <OK> button    <BACK> button

 <Fn> key    <CLEAR> key

 z Indicates your PC keyboard.

[ ]  z Indicates menu names on the display screen.
 z Indicates menu, window, and dialog names on the computer.

" "
 z Indicates messages and input text on the display screen.
 z Indicates file names and screen names on the computer. 
 z Indicates reference titles.

> Indicates how to get to the item you want in the menu of this printer or 
the computer.
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Illustrations
Unless otherwise specified, the printer illustrations used herein show the printer with the unwinder 
mounted.

Illustrations may differ from the actual product.

Screens
The images of the control panel and PC used herein are examples. The images may differ from actual 
products and screens.

Inscriptions
The following inscriptions are used in this manual.

 z Microsoft® Windows® 10 64-bit Edition operating system → Windows 10 (64-bit version)

 z Microsoft® Windows® 10 operating system → Windows 10

Unless otherwise specified, the examples in the manuals included with the printer show operation using 
Windows 10 and the Pro 1050 printer.

Depending on the OS, model, and version you are using, descriptions in this manual may differ from 
what you actually encounter.
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Note

 z The examples in this chapter use Windows WordPad for explanations. Depending on the 
application, the screens and operations procedures may differ.

 z For detailed explanations of the printer driver and utility setup items, see "Online Help".

 z Due to printer driver and utility version upgrades, actual operations may be different from the 
descriptions in this manual.
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Printing on Various Papers

 Printing on Various Papers

Usable Media Types
For high-quality printing it is necessary to use paper that satisfies conditions regarding quality, 
thickness, paper finish, etc. If printing on paper not recommended by OKI, thoroughly test the print 
quality and paper traveling performance, etc., and check that there are no impediments before use.

If using a (paper) medium that is curled or wrinkled before printing, print quality and paper traveling 
performance cannot be assured.

Paper Types, Size, and Thickness

 �Roll Paper Specifications

Reference

 z Refer to the “Maintenance Guide” for specific paper sizes.

Roll Paper Types

Media Form Description
Continuous Paper Paper wound on a roll
Continuous Paper (Black Mark) Paper wound in a roll with black marks printed on the back surface
Die-cut Label (Gap) Paper that is die-cut into a label shape
Die-cut Label (Black Mark) Paper that is die-cut into a label shape with black marks printed on the back 

surface
Continuous Label Paper that is not die-cut into a label shape, with the entire surface covered with 

label paper
Continuous Label (Black Mark) Paper that is not die-cut into a label shape, with the entire surface covered with 

label paper and black marks printed on the back surface

Media Type Description
Plain Wood-free Paper
Plain Labels Label paper made of wood-free paper
Glossy Labels Label paper made of glossy paper
Film Labels Label media made of film
Film Film

Roll Paper Size

Roll Outside Diameter No greater than 203.2 mm (8 inches)
Paper Width 25.4 to 130 mm (1 to 5.12 inches) 
Paper Thickness 0.07 mm to 0.25 mm* (0.003 to 0.0098 inches)
Roll Core Width Same as roll paper
Roll Core Inner Diameter 76.2 mm 

* When there is backing paper, total thickness includes backing paper.

Note `

 z Using metal foil paper or conductive paper creates the risk of defective printing due to electrical discharge, and device 
malfunction.

Use of metal foil paper and conductive paper is prohibited.

 z Using ink jet paper or label paper will cause device malfunction. Use of ink jet paper or label paper is prohibited.

 z Use paper that has black marks printed on its back surface (non-printing surface). Black marks printed on the front surface 
cannot be detected.

 z Use paper with black marks printed with carbon ink. Use paper with black marks that have a reflective index of less than 10%.
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Printing on Various Papers

 z Die-cut labels that are used in Gap Mode must satisfy the following conditions.

The transparency of the label part (including both the label and the label liner) must be below 25%.

The liners must be within a range of 10% to 45% transparent. However, the transparency of the liners must be more than 1.8 
times the transparency of the label part.

 z Die-cut labels that are used in Gap Mode cannot use transparent liners or labels.

 z Die-cut labels that are used in Black Mark Mode cannot use transparent liners.

 z Use continuous labels that have been smoothed on both edges and have been dry edge processed. Recommended 
specifications are for paper that has 2 mm of liner on both edges. Please refer to the “Maintenance Guide” for details.

 z Thermal paper will become discolored and deformed by heat used for fusing. Do not use it.

 z Use film that can withstand heat up to 230°C. Use of film that is not heat resistant creates the risk of film deformation by heat 
used for fusing, paper jams, and device malfunction.

 z Do not use a liner on which glue is smeared. It will not feed correctly in the equipment. In the worst case, it could damage the 
equipment.

 z Cast-coated paper is not recommended. Printing quality cannot be guaranteed when it is used. 

 z If the paper length, label length, or black Mark Interval for a single sheet is less than 4 inches, blank sheets may be printed to 
satisfy the paper length that can be fed.

 z When printing on paper that is cut to less than 152 mm (6 inches) long in the direction that media is fed, it may feed at an 
angle.

If this happens, print it so there is a continuous length that is longer than 152 mm (6 inches).

 z When printing on paper that is very narrow (25.4 mm (1 inch)), it may feed at an angle at about 80 mm from the cut trailing 
edge.

 z When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), smeared or smudged printing may occur near 
the cut trailing edge as the roll diameter gets smaller.

 z When printing on inside winding paper that is very narrow (25.4 mm (1 inch)), slight damage may occur at the leading edge 
as the roll diameter gets smaller.

 z Use of the types of paper below is not supported.

Paper whose roll surfaces are not cut cleanly.

Paper that is connected part way through by tape, etc.

Label paper without backing paper with paste on the front surface

Paper whose labels are easy to peel or are peeling

Paper with paste squeezing out onto the base paper area or affixed to the label surface

Paper that is folded or bent

Paper that has holes in it

Paper that is notched

Paper that has perforations

Paper with different size labels on a single roll

Paper with different paper widths on a single roll

Media that has liners and labels that are both transparent (cannot be used even if it has black marks)

Continuous paper that is transparent (cannot be used even if it has black marks)

 �Setting the Paper Weight
Set the printer and printer driver paper weight according to the weight of the paper to be used.

Paper Weight 
 (Total thickness including 

backing paper)

Setting Value of the  
Media Weight

76 to 95 μm Light
96 to 140 μm Medium Light
141 to 159 μm Medium
160 to 180 μm Medium Heavy
181 to 199 μm Heavy
200 to 214 μm Ultra Heavy1
215 to 229 μm Ultra Heavy2
230 to 249 μm Ultra Heavy3
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Printing on Various Papers

Storing Media
Improper paper storage can cause absorption of 
moisture, discoloration, and warping. Note that 
printing on such paper can adversely affect print 
quality, feeding, etc. Leave packages of media 
unopened until you are actually ready to use 
them.

 �Store media in locations like the 
ones described below

 z On a flat shelf in a location that is dark and 
where there is little moisture

 z On a flat table

 z An environment with a temperature of 23°C 
±1°C and humidity of 50%RH ±2%

 �Avoid locations like the ones 
described below

 z Directly on the floor

 z In direct sunlight

 z Near the inside surface of an external wall

 z On a surface that is uneven or curved

 z In a location where electrostatic charge is 
generated

 z In a location subjected to very high 
temperatures or sudden temperature changes

 z Next to a photocopying machine, air 
conditioning equipment, heater, or duct

Note

 z Proper printing may not be possible on paper that has 
been stored for a long time.

 z Leaving roll paper in an environment where it is exposed 
to high temperatures and high humidity for long periods 
can cause it to become deformed. Do not use deformed 
roll paper. Store roll paper in an environment where the 
temperature and humidity are appropriate.

 z We recommend putting partially used label paper back 
into the vinyl bag it was packaged in, to prevent the paper 
from absorbing moisture.
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Registering a Desired Paper Size with the Printer Driver

 Registering a Desired Paper Size with the Printer 
Driver

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [User-defined 
paper].

5 Input information about the paper you 
want to register.

(1) Use [Registered user-defined 
paper] to select "New Paper".

(2) In the [Paper Name] box, enter a 
paper name.

(3) Select a Media Form to match the 
paper.

(4) Select a Media Type to match the 
paper.

(5) Select a Media Weight to match the 
paper thickness.

Memo

 z If you are unsure of the paper thickness, 
select [Medium Light].

(6) Enter paper size information.

(2)

(4)
(3)

(1)

(5)

(6)

Memo

 z Input the label length and gap for media that has 
gaps and the black mark interval for black mark 
media.

 z Use a ruler to measure, as accurately as possible, 
the actual size of the media, and then input those 
values.

 z If the label length or the black mark interval is less 
than 4 inches, use the following method to measure 
the media, and then input values to the first decimal 
place to be accurate.

1 3 4 5 6 7 8 9 10 11

(3)L/10-Gap length(mm)

(1)L(mm)
(2)L/10(mm)

 

2

How to Measure the Actual Size of Paper

(1) Measure the length from the leading edge of the 
first label (or black mark leading edge) to the 
leading edge of the 11th label (or black mark 
leading edge). Use this as L (mm).

(2) Divide the length you measured in (1) by 10 to 
calculate the length from the leading edge of the 
first label (or black mark leading edge) to the 
leading edge of the 2nd label (or black mark leading 
edge) to the first decimal place.

(3) Subtract the length of the gap from the length you 
calculated in (2) to calculate the length of one label 
to the first decimal place.

For media that has gaps, input the value calculated in (3) 
in [Label length] and input the gap length in [Gap].

For media that has black marks, input the value 
calculated in (2) in [Black Mark Interval].
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Registering a Desired Paper Size with the Printer Driver

Memo

 z A blank piece of paper may be inserted after cut 
pages if the paper length, label length, or black 
mark interval is less than 4 inches.

6 Enter other information as required.

(1) If you performed sensor 
adjustment, select the sensor 
setting that was registered to the 
device from [Sensor settings].

Memo

 z Refer to “Calibrating the Sensor” (P.30) 
regarding how to adjust the sensor.

(2) If you want to fine-tune the 
image position, enter the position 
shift amount into [Print position 
correction].

(3) If you want to fine-tune the paper 
cut position, enter the position 
shift amount into [Cut position 
correction].

(2)

(1)

(3)

7 When all the input is complete, click 
[Add].

Using the Printer Driver 
to Fine-tune the Print 
Position

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [User-defined 
paper].



- 17 -

Registering a Desired Paper Size with the Printer Driver

5 Use the [Registered user-defined paper] 
list to select the paper whose print 
position you want to correct.

Memo

 z If the paper you want to use is not in the list, select 
[New paper] and add it. See “Registering a Desired 
Paper Size with the Printer Driver” (P.15).

6 In [Print position correction], set the 
values for the print start positions 
vertically and horizontally on the paper.

7 Click [Overwrite].

8 Click [OK] or [Close] as many times 
as necessary to exit the "Printing 
preferences" screen.

9 Open the file to be printed.

10 Specify the paper size, and then print.
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Registering a Desired Paper Size with the Printer Driver

Using the Printer Driver to 
Fine-tune the Cut Position

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [User-defined 
paper].

5 Use the [Registered user-defined paper] 
list to select the paper whose cut 
position you want to correct.

Memo

 z If the paper you want to use is not in the list, select 
[New paper] and add it. See “Registering a Desired 
Paper Size with the Printer Driver” (P.15).

6 Use [Cut position correction] to specify 
an adjustment value for distance from 
the print completion position to the cut 
position.

7 Click [Overwrite].
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Registering a Desired Paper Size with the Printer Driver

8 Click [OK] or [Close] as many times 
as necessary to exit the “Printing 
preferences” screen.

9 Open the file to be printed.

10 Specify the paper size, and then print.
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Registering a Desired Paper Size with the Printer Driver
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Printing
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Note

 z The examples in this chapter use Windows WordPad for explanations. Depending on the 
application, the screens and operations procedures may differ.

 z For detailed explanations of the printer driver and utility setup items, see "Online Help".

 z Due to printer driver and utility version upgrades, actual operations may be different from the 
descriptions in this manual.
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Preparing Paper

 Preparing Paper
This section describes how to load paper onto the holder of the unwinder.

For paper sizes and types that can be loaded onto the unwinder, see “Roll Paper Specifications” (P.12).

1 Remove the paper from the packaging.

2 Take care of the tape that is holding the 
leading edge of the paper.

If there is no tape holding the leading 
edge of the paper, you can just load it 
as is.

(1) Remove the tape that is holding 
the leading edge.

Note

 z Remove the tape that is holding the leading 
edge of the paper before you use it. Do not 
load paper while the tape is still attached and 
feed it into the equipment. There is a risk of 
damaging the equipment.

(2) Cut off the part of the paper on 
which there is leftover adhesive.

Note

 z There is a risk of adhesive being left over 
after removing the tape. If paper that still 
has adhesive on it is fed into the equipment, 
the adhesive may stick to the feed path and 
damage the equipment.

Cutting off the part of 
the paper on which there 
is leftover adhesive (2)

Tape is removed (1)

Adhesive from tape

3 Check the leading edge of the paper 
and cut it off straight.

If the leading edge of the paper is cut 
straight, you can just load it as is.
Be particularly careful when replacing 
paper and after removing and reloading 
jammed paper.

(1) When loading paper, cut the 
leading edge of the paper straight 
before loading it.

Note

 z Do not cut at an angle, do not cut black 
marks, and do not cut labels. Depending 
on the size and shape of the leading edge, 
there is a risk of skewing the print position, 
not being able to print, or damaging the 
equipment.

 z Standard media and continuous labels 
(dry edge)

 z Standard media (with black marks) and 
continuous labels (dry edge)

BM BM

1.2 to 4.0 mm
(0.0472 to 0.1575 
inches)
Length of leading 
margin when paper 
is loaded

1.2 to 4.0 mm
(0.0472 to 0.1575 
inches)
Length of leading 
margin when paper 
is loaded
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Preparing Paper

 z Die-cut label paper (no black marks)
1.2 to 6.5 mm
(0.0472 to 0.2559 inches)
Length of leading liner 
when paper is loaded

 z Die-cut label paper (with black marks)

BM

BM

1.2 to 4.0 mm
(0.0472 to 0.1575 inches)
Length of leading margin 
when paper is loaded
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Loading Media

 Loading Media
Load the paper onto the Unwinder. For paper sizes and types that can be loaded on the Unwinder, see 
“Roll Paper Specifications” (P.12).

Note

 z When setting roll paper, be careful not to drop it. As roll paper is heavy, when you drop it, there is a risk of injury.

 z If you drop roll paper, it may roll on the floor and cause injury to the people around.

 z To prevent roll paper from dropping, store it horizontally on a desk, etc.

 z Do not use any roll paper that is not specified by the Roll Paper Specifications.

Memo

 z If the printer is turned OFF, press the <POWER> button to turn it on.

1 Open the Flange Locking Lever.

2 Remove the flange.

3 Rotate the Roll Paper Holder Knob to 
contract the Roll Paper Holder shaft.
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Loading Media

4 Slide roll paper onto the Roll Paper 
Holder shaft as far as it will go.

Note

 z Make sure to slide the roll paper as far as it will go.  
Insufficiently sliding the roll paper can adversely 
affect print position accuracy.

 z Take care to avoid pinching your fingers or hands 
when sliding the roll paper.

5 Rotate the Roll Paper Holder Knob to fix 
the roll paper core in place.

Note

 z Rotate the Roll Paper Holder Knob until it clicks.

6 Aligning the Flange with the Roll Paper 
Holder shaft as shown in the illustration, 
attach the Flange.

7 Slide the Flange as far as it will go in 
accordance with the roll paper width.

 

Note

 z Slide the Flange up to the side of the loaded roll 
paper.

 z Take care to avoid pinching your fingers or hands 
when attaching the Flange.
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Loading Media

8 Close the Flange Locking Lever.

 

Note

 z After loading roll paper, take care not to rest your 
body weight on the top of the Roll Paper Holder 
shaft. Doing so risks causing injury due to the 
device falling.

9 Lower the Unwinder Cover Open Lever 
to open the Unwinder Cover.

Open the Unwinder Cover manually in 
the direction indicated by the arrow 
until it locks.

Note

 z Open the Unwinder Cover until it locks securely.
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Loading Media

10 Before loading the paper, rotate the Roll 
Paper Guide Adjustment Knob clockwise 
and move the Roll Paper Guide towards 
you.

 

11 Pull up the F0 Roller Release Lever.

12 Press the Tension Bar Open Lever 
upwards until it clicks.

 

13 Pass paper below the Tension Bar and 
F0 Roller, and align the leading edge of 
the paper with the Roll Paper Guide and 
Paper Guide.

Roll Paper Guide
*D shape metallic pin

Paper Guide

14 Check the paper status from the 
direction indicated by the arrow.
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15 Rotate the Roll Paper Position 
Adjustment Dial to adjust the paper 
until it is straight.

Roll Paper Position 
Adjustment Dial

D

C A

B

Memo

 z If you rotate the Roll Paper Position Adjustment Dial 
in 
direction A→the roll paper moves in the direction C 
direction B→the roll paper moves in the direction D

16 Lower the F0 Roller Release Lever to fix 
the roller in place.

17 Press down on the Tension Bar Open 
Lever until it clicks.

18 After loading the paper, rotate the 
Roll Paper Guide Adjustment Knob 
counterclockwise and align the Roll 
Paper Guide to the width of the paper.

Note

 z Set the Roll Paper Guide correctly. If the Roll Paper 
Guide is not set correctly, the width of the paper 
cannot be detected correctly.

 z Be careful that the Roll Paper Guide does not press 
too strongly on the paper. Doing so could damage 
the paper.

 z Do not allow too much of a gap between the paper 
and the Roll Paper Guide. Doing so could allow the 
paper to twist and the print position to shift.

 z When setting the Roll Paper Guide to the width of 
the paper, rotate the Roll Paper Guide Adjustment 
Knob counterclockwise, as shown in the following 
diagram, to make the Roll Paper Guide narrower 
so it matches the width of the paper. If it is too 
narrow, rotate the Roll Paper Guide Adjustment 
Knob clockwise to first open the Roll Paper Guide 
wider, and then make it narrower.
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Gap is too large

Roll Paper Guide is aligned to width of paper

Roll Paper Guide is too tight

19 Close the Unwinder Cover.

Note

 z When closing the Unwinder Cover, there is a risk of 
pinching your fingers or hands. Press the top of the 
Unwinder Cover to close it.

This completes setting roll paper.

Memo

 z If, even though the roll paper is set correctly, the 
paper separates from the Unwinder Paper Guide 
during printing, rotate the Roll Paper Position 
Adjustment Dial in the B direction to adjust it so the 
paper does not separate from the Unwinder Paper 
Guide. 
As a guideline, the adjustment should be the same 
distance that the paper is separated from the 
Unwinder Paper Guide. 
Each notch on the adjustment scale at the base of 
the Roll Paper Position Adjustment Dial is 1 mm.

Adjustment notches

A

B
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 Calibrating the Sensor
Note `

 z Check the position of the sensor each time you load paper. 
Check the position of the sensor in the following cases especially. 
- When you load a different type of paper 
- When you switch the type of sensor from black mark sensor to gap sensor 
- When you switch the type of sensor from gap sensor to black mark sensor

 z If the sensor position settings do not match, paper feed jams may occur, you cannot adjust the black mark sensor or the gap 
sensor, and the skew in the adjusted values may cause the print position to skew.

Confirming the Sensor 
Position

Unwinder

1 Lower the Unwinder Cover Open Lever 
to open the Unwinder Cover.

Open the Unwinder Cover manually in 
the direction indicated by the arrow 
until it locks.

Note

 z Open the Unwinder Cover until it locks securely.
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2 Confirm the sensor position.

The “∆” indicates the 
black mark sensor 
position

Position During Regular Usage
Factory setting is this position.

The “│” indicates 
the gap sensor 
position

Edge of 
paper

10 mm from 
edge of paper

16.5 mm 
from edge 
of paper

Edge of 
paper

Sensor Position Adjustment Dial

(1) Check the black mark sensor 
position
Align the paper, and check the 
actual position of the black mark 
and the black mark sensor position.

Black mark (on back 
side of paper)

If the position of the black mark 
and the black mark sensor position 
do not align, rotate the Sensor 
Position Adjustment Dial to adjust 
the position (go to step 3).

Black mark (on back 
side of paper)

The black mark sensor position is 
set 10 mm from the edge of the 
paper. 
If the black mark is 15 mm or 
more from the edge of the paper, 
you do not need to adjust it.
If the black mark is 15 mm or less 
from the edge of the paper, adjust 
the position of the ∆ so it is in the 
center of the black mark.

(2) Check the gap sensor position
Align the paper, and check the 
actual position of the label and the 
gap sensor position.

Label

Liner
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If the position of the label and the 
gap sensor position do not align 
in relation to the regular usage 
position, rotate the Sensor Position 
Adjustment Dial to adjust the 
position (go to step 3).

Label

5mm
Width of the 
right edge 
of the liner

The gap sensor position is set 16.5 
mm from the edge of the paper. 
If the width of the right edge of 
the liner is 10 mm or less, then 
adjustments are not necessary.
If the width of the right edge of the 
liner is 10 mm or more, then adjust 
the gap sensor using the above 
positions as a rough estimate.
If the corners of the label are 
rounded, then consider the position 
of the radius of the corner. 
Refer to the following example of 
adjusting the position.

Label

Radius of 
corner

5mm

3 Rotate the Sensor Position Adjustment 
Dial to adjust the sensor position.

A

B

D

C

Memo

 z If you rotate the Sensor Position Adjustment Dial in 
direction A→the sensor position moves in the 
direction C 
direction B→the sensor position moves in the 
direction D
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Printer

1 Grasping the Top Cover Open Lever, 
open the Top Cover.

2 Remove the Print Cartridge Set and the 
Belt Unit.

Memo

 z Refer to “Maintenance Guide” for the procedure to 
install the print cartridge set and belt unit.

3 Confirm the sensor position.
Sensor Position Adjustment Dial

Position During 
Regular Usage
Factory setting 
is this position.

The “│” indicates the 
gap sensor position

Edge 
of 
paper

The “

∆

” indicates the 
black mark sensor 
position

65 mm from 
edge of paper

58.5 mm from edge 
of paper
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(1) Check the black mark sensor 
position
Confirm the center of the black 
mark on the media and the black 
mark sensor position on the device 
(number on the  indicator).
If the position of the black mark 
and the black mark sensor position 
do not align, rotate the Sensor 
Position Adjustment Dial to adjust 
the position (go to step 4).
The black mark sensor position is 
set, at the factory, to 58.5 mm from 
the right edge of the label liner.
Adjust the position of the “” so it 
is in the center of the black mark 
of the media you are using.

Black mark 
(on back side or paper)

 

Center of black mark

(2) Check the gap sensor position
Confirm the center of the label 
on the media and the gap sensor 
position on the device (number on 
the | indicator).
If the position of the label and 
the gap sensor position do not 
align, rotate the Sensor Position 
Adjustment Dial to adjust the 
position (go to step 4).
The gap sensor position is set, at 
the factory, to 65 mm from the 
right edge of the label liner.
Adjust the position of the “ | ” so it 
is in the center of the labels of the 
media you are using.

Center of label

4 Rotate the Sensor Position Adjustment 
Dial to adjust the sensor position.

A
B

D

C

Memo

 z If you rotate the Sensor Position Adjustment Dial in 
direction A→the sensor position moves in the 
direction C 
direction B→the sensor position moves in the 
direction D
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Sensor Calibration

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [User-defined 
paper].

5 Input information about the paper you 
want to register. To adjust settings that 
are already registered, select the names 
of the paper from the list in [Registered 
user-defined paper].

6 Click [Sensor Adjustment].

Memo

 z [Sensor Adjustment] appears if the following 
conditions are met.

 - The Media Form is one of the following  
   Continuous Paper (Black Mark) 
   Die-cut Label (Gap) 
   Die-cut Label (Black Mark) 
   Continuous Label (Black Mark)

 - The [Ports] of the printer driver is USB or 
standard TCP/IP port

 z Before performing [Sensor Adjustment], make sure 
that the printer is “online”.

 z If [Sensor Adjustment] does not appear, advance to 
step 12 of this procedure.

7 Click [Next].

Memo

 z Before performing the next steps of this procedure, 
make sure that paper is loaded.

 z If there are no paper size settings configured on the 
control panel, it may cause a paper size mismatch 
on the device. Pressing the <OK> button on the 
control panel overwrites the device paper size 
setting with the paper size setting in the printer 
driver.
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8 Select a registration location (a) for 
the adjustment, and then enter a 
registration name (b).

(b)

(a)

Memo

 z You can enter up to eight alphanumeric English 
characters for the registration name.

9 Click [Next].  
This starts the sensor adjustment and 
displays a wait message.

10 When the completion screen appears, 
click [Complete].

Memo

 z The results of adjusting the sensor are registered 
on the printer. In [Sensor settings] in [User-defined 
paper] in the printer driver, you can specify the 
number registered in the printer for the adjustment 
results and whether to apply it when printing. By 
standardizing the registration numbers of the sensor 
adjustment results, you can get the same print 
results by specifying the same number in [Sensor 
settings] in the printer driver for any printer. This is 
useful when printing on the same media on multiple 
printers.

11 To register new settings, click [Add] or 
click [Overwrite] to select paper that is 
already registered.

12 Click [OK] or [Close] as many times 
as necessary to exit the “Printing 
preferences” screen.

13 Open the file to be printed. 

14 Specify a registered paper size, and 
then print.
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If You Cannot Set the Sensors from the Printer Driver
If you cannot set the sensors from the printer driver, then set them from the control panel.

Black mark sensor Gap sensor

Confirm the sensor position

Configure the sensor type
Media form = Continuous Paper (Black Mark)

              Die-cut Label (Black Mark)
                    Continuous Label (Black Mark)

Configure the sensor type
Media form = Die-cut Label (Gap)

Configure the paper size
Paper Size = Custom

X Dimension = Input the “label width”
For die-cut labels (black marks):
  Paper length = Input the “label length”
   Gap Length = Input the “gap length”
Otherwise:
  Black mark interval =  Input the “length between 

black marks”

Configure the paper size
Paper Size = Custom

X Dimension = Input the “label width”
Y Dimension = Input the “label length”
Gap Length = Input the “gap length”

Execute sensor calibration
Sensor calibration → Execute
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Calibrating the Black Mark 
Sensor

You can adjust the black marks on roll paper 
using the black mark sensor.

Here, we will show the method when Continuous 
Label (Black Mark) are used.

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <8>, <9>, <1> (function 
numbers), and then press the <OK> 
button.

3 Select [6. Continuous Label (Black 
Mark)], and then press the <OK> 
button.

4 Press the <ON LINE> button to return 
to the standby screen.

5 Press the <Fn> key, and then press the 
following buttons: <9>, <0>, <OK>.

6 On the Paper Size menu, select 
[Custom], press the <OK> button, and 
then press the <ON LINE> button.  
The display will return to the standby 
screen.

7 Press the <Fn> key, and then press the 
following buttons: <9>, <1>, <OK>.

8 Use the numeric keypad to enter the 
label width, press the <OK> button, 
and then press the <ON LINE> button.  
The display will return to the standby 
screen.
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9 Press the <Fn> key, and then press 
the following buttons: <8>, <9>, <0>, 
<OK>.

10 Select [Black Mark Interval] from 
[Unwinder Config], and then press the 
<OK> button.

11 Use the numeric keypad to enter the 
Black Mark Interval, press the <OK> 
button, and then press the <ON LINE> 
button.  
The display will return to the standby 
screen.

12 Press the <Fn> key, and then press 
the following buttons: <8>, <9>, <3>, 
<OK>.

13 Select the setting number of the sensor 
to be configured, and then press the 
<OK> button.

14 Select [Execute Calibration], and then 
press the <OK> button.

15 Enter the sensor calibration name, and 
then press the <OK> button.

Memo

 z You can leave the name blank, if you want.

16 If an execution confirmation screen 
appears, select [Yes].

17 This executes sensor calibration.
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18 After sensor calibration is complete, 
press the <OK> button.

Calibrating the Gap Sensor
You can adjust the distance between die cut 
labels using the gap sensor.

1 Press the <Fn> key.  
The numerical values input screen will 
be displayed.

2 Press <8>, <9>, <1> (function 
numbers), and then press the <OK> 
button.

3 Select [3. Die-cut Label (Gap)], and 
then press the <OK> button.

4 Press the <ON LINE> button to return 
to the standby screen.
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5 Press the <Fn> key, and then press the 
following buttons: <9>, <0>, <OK>.

6 On the Paper Size menu, select 
[Custom], press the <OK> button, and 
then press the <ON LINE> button.  
The display will return to the standby 
screen.

7 Press the <Fn> key, and then press the 
following buttons: <9>, <1>, <OK>.

8 Use the numeric keypad to enter the 
label width, press the <OK> button, 
and then press the <ON LINE> button.  
The display will return to the standby 
screen.

9 Press the <Fn> key, and then press the 
following buttons: <9>, <2>, <OK>.

10 Use the numeric keypad to enter the 
label length, press the <OK> button, 
and then press the <ON LINE> button.  
The display will return to the standby 
screen.

11 Press <8>, <9>, <0> (function 
numbers), and then press the <OK> 
button.

12 Select [Gap Length] from [Unwinder 
Config], and then press the <OK> 
button.
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13 Use the numeric keypad to enter the 
gap length, press the <OK> button, 
and then press the <ON LINE> button.  
The display will return to the standby 
screen.

14 From here, perform the same steps as 
those under “Calibrating the Black Mark 
Sensor” from step 12 of this procedure.
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 Detecting the Interval between Pages 

 �When executing from the printer 
driver

You can use the following procedure, from the 
printer driver, to register the paper gap and black 
mark interval on the device. Registering these 
settings improves your printing results. However, 
it does waste approx. 10 sheets of paper.

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers]. 

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [User-defined 
paper].

5 After confirming that the paper name 
you entered in the “Paper Name” box is 
shown under [Registered user-defined 
paper], click [Close].

6 For [Paper settings], select the paper 
settings you registered, and then click 
[Paper interval detection].

Memo

 z [Paper interval detection] is displayed if the 
following conditions are met.

 - The Media Form is one of the following 
  Continuous Paper (Black Mark) 
  Die-cut Label (Gap) 
  Die-cut Label (Black Mark) 
  Continuous Label (Black Mark)

 - The [Ports] of the printer driver is USB or 
standard TCP/IP port

 z If [Paper interval detection] does not appear, 
advance to step 8 of this procedure.

7 Confirm the displayed paper 
information, and then click [Measure].

This starts checking the media pitch 
and closes the dialog box.

Memo

 z If you change to another type of paper, you should 
execute this paper interval detection again.

8 Click [OK] as many times as necessary 
to exit the “Printing preferences” 
screen.

9 Open the file to be printed.

10 Specify a registered paper size, and 
then print.
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 �When executing from the control 
panel

Detect the paper gap and black mark interval 
from the control panel.

1 For black mark media, execute steps 
1 to 11 in “Calibrating the Black Mark 
Sensor” (P.38).

For gap media, execute steps 1 to 13 in 
“Calibrating the Gap Sensor” (P.40).

2 Press the <Fn> key.

3 Press <8>, <9>, <4> (function 
numbers) and then press the <OK> 
button.

4 Select [Execute], and then press the 
<OK> button to start paper interval 
detection and close the dialog box.



- 45 -

Printing

 Printing
After loading the paper, use the computer to open the file you want to print. Next, use the printer driver 
to select the [Paper settings], and then print.

Memo

 z When printing on label paper for the first time, execute [Sensor Adjustment] before printing.

Reference

 z For detailed explanations of the printer driver setup items, see “Online Help”.

 z For information about how to load paper, see “Loading Media” (P.24).

 �Windows PCL Printer Driver
Here, we will show how to print an open 
WordPad file as an example.

1 Select [Page Setup] in the [File] menu.

2 Select the paper size and print 
orientation, and then click [OK].

3 On the [File]  menu, click [Print] > 
[Print].

4 Click [Preferences].

5 On the [Setup] tab, configure [Paper 
settings].

Memo

 z Configure the [Cut Mode] setting on the [Setup] tab 
as required. 

6 When the settings are complete, click 
[OK] in the “Setup” screen.

7 Click [Print] in the “Print” screen to 
print.

8 When the screen shown below 
appears on the control panel, if the 
loaded media is incorrect, press the 
<UNLOAD> button to remove the 
loaded media and load the correct 
media. If the loaded media is correct, 
press the <OK> button.

Memo

 z When Paper settings of the printer driver and the 
menu setting on the printer are not the same, the 
confirmation screen shown above appears on the 
control panel to prevent paper jams during printing 
and label pieces occurred during cutting.

 z The different settings are indicated with “!” mark. 
Check if the loaded media matches the setting.

 z When you reload media or press the <OK> 
button, the settings indicated with “!” mark will be 
overwritten to the printer.
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 Canceling a Print Job
Use the procedure below to cancel a print job from the printer’s control panel.

1 On the control panel, press the 
<CANCEL> button.

 

2 If a verification message appears, select 
[Yes], and then press the <OK> button.
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Settings
Printer Driver Functions Table ……… 48

Table of Setting Items  
in the Control Panel Menu Screen … 50

Saving Toner When Printing ………… 79

Fine Quality Printing …………………… 81

Adjusting the Print Position  
on the Paper ……………………………… 84

Other Print Functions ………………… 87

Deleting or Updating a  
Printer Driver …………………………… 97

Note

 z The examples in this chapter use Windows WordPad for explanations. Depending on the 
application, the screens and operations procedures may differ.

 z For detailed explanations of the printer driver and utility setup items, see "Online Help".

 z Due to printer driver and utility version upgrades, actual operations may be different from the 
descriptions in this manual.
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 Printer Driver Functions Table
This section explains the convenient functions when printing from a PC.

Reference

 z For detailed explanations of the printer driver setup items, see "Online Help".

Explanation of Functions

Windows PCL Printer Driver Functions

[Setup] Tab

Item Description
Example Shows what printing results 

will be based on current 
settings. This example is just 
an approximation and does not 
indicate the exact actual number 
of print pages and cut positions.

Paper settings Specifies, from among 
registered paper settings, 
which one should be applied for 
printing.

Orientation Specifies the print orientation.
Copies Specifies the quantity to be printed.
Cut Mode Specifies the timing to cut roll paper 

when cutting and printing on it.
Quality Specifies the resolution during 

printing.
Screen Specifies the halftoning available 

with the device.
User-defined 
paper

Click when using the driver to 
register paper settings to be 
used for printing.

Paper interval 
detection

Before printing to black mark or 
die-cut labels, click to execute 
learning on the device to 
improve the print position before 
starting.
Note that executing this function 
will cause some paper to be used.

About Displays the printer driver 
version information.

Default Restores default settings.

[User-defined paper]

Item Description
Paper Name Enter the name of the paper 

settings you want to register.
Registered user-
defined paper

Shows a list of paper settings 
that have been registered.

Size Specifies either millimeters 
or inches as the unit for input 
values.

Print position 
correction

Adjusts the print start position 
on the paper edge.

Cut position 
correction

Adjusts the cut position when 
cutting and printing roll paper.

Media Form Specifies the paper setting type 
to be registered.
Size input items change in 
accordance with this setting.

Media Type Specifies the paper type.
Media Weight Specifies the paper thickness.
Sensor settings Specifies the settings, from 

among those registered on the 
device, to be used for printing.

Sensor 
Adjustment

Click to calibrate the gap of 
black mark or die-cut labels, and 
register the results as device 
sensor settings.
This button is not displayed for 
media forms that do not require 
calibration.

Printer 
information 
acquisition

Obtains, from devices, the 
names of settings registered as 
sensor settings and the names 
of user types registered as 
paper types, and reflects them 
in the sensor settings and paper 
type list on the printer driver.
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[Color] Tab

Item Description
Color Mode Selects either color printing 

or monochrome printing.
When color is selected, 
clicking [Detail] displays the 
"Detail" dialog box, which can 
be used to configure detailed 
color printing settings.

Spot Color* Specifies how white toner 
should be used for printing.

Toner Saving Specifies the print density 
when economizing on toner.

*: This item available only on the Pro1050

[Overlays] Tab

Item Description
Overlays Specifies whether or not a 

form should be overlaid on the 
document to be printed, or 
whether the document should be 
registered as a new form in the 
device.

[Extend] Tab

Item Description
Watermarks Sets when implementing 

stamp printing.
Fonts Configures TrueType and 

printer font settings.
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 Table of Setting Items in the Control Panel Menu 
Screen

Device Setup Screen
Item Description

Configuration View device information (total number of sheets, remaining consumable quantity, 
system information, etc.)

Print Information Print the settings, usage report, error log, color profile list, and user media lists for 
this machine.

Menus Used to configure system settings, print position adjustment, color, and other 
settings.

Admin Setup Administrator sets the network settings, changes passwords, etc.
Print Statistics Check the print use status of the user.
Calibration Used to adjust the color densities and shades, color misalignment, etc.
Boot Menu Set whether or not to restart the printer when a malfunction occurs in the HDD or 

file system, etc.

[Configuration]
Item Description

Feeder Count Unwinder nnnnnn Displays the total print quantity for the unwinder. (This 
is the number of sheets converted into the A6 size paper 
from the length of paper fed from the unwinder.)

Supplies Life Cyan Print Cartridge Remaining 
nnn%

Shows the remaining service life (%) of each color's print 
cartridge.

Magenta Print Cartridge Remaining 
nnn%

Yellow Print Cartridge Remaining 
nnn%

Black Print Cartridge Remaining 
nnn%

White Print Cartridge *1 Remaining 
nnn%

Waste Toner Box Remaining 
nnn%

Shows the remaining service life (%) of the waste toner 
box.

Belt Remaining 
nnn%

Shows the remaining service life (%) of the belt unit.

Fuser Remaining 
nnn%

Shows the remaining service life (%) of the fuser unit.

*1:  Displayed with Pro1050 only.
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Item Description
Network Printer Name **********

**********
***********

Shows the printer name used by the DNS and Network 
PnP.

Short Printer Name *******
********

Displays the short printer name.

IPv4 Address xxx.xxx.xxx.
xxx

Shows the IP address. When TCP/IP is enabled, shows the 
setup of the following control panel setting [Admin Setup] 
> [Network Setup] > [IPv4 Address].

Subnet Mask xxx.xxx.xxx.
xxx

Displays the subnet mask. When TCP/IP is enabled, shows 
the setup of the following control panel setting [Admin 
Setup] > [Network Setup] > [Subnet Mask].

Gateway Address xxx.xxx.xxx.
xxx

Displays the gateway address. When TCP/IP is enabled, 
shows the setup of the following control panel setting 
[Admin Setup] > [Network Setup] > [Gateway Address].

MAC Address xx:xx:xx:
xx:xx:xx

Shows the MAC address.

Network FW Version xx.xx Shows the network firmware version.
Web Remote Version xx.xx Shows the web page version.
IPv6 Address (Local) xxxx:xxxx:xx

xx:xxxx:xxxx
:xxxx:xxxx:x
xxx

Shows the (local) IPv6 address. This menu is not displayed 
when TCP/IP is disabled or when the IP version is IPv4.

IPv6 Address 
(Global)

xxxx:xxxx:xx
xx:xxxx:xxxx
:xxxx:xxxx:x
xxx

Shows the (global) IPv6 address. This menu is not 
displayed when TCP/IP is disabled or when the IP version 
is IPv4.

System Serial Number xxxxxxxxxx
xxxxxxxxxx
xxxxxx

Displays the serial number.

Asset Number xxxxxxxxxx
xxxxxxxxxx
xxxxxxxxxxxx

Displays the asset number of the printer manager.

Firmware Version xxx.xx_x_x Shows the version number of FirmSuite.
CU Version xx.xx Displays the control unit firmware version.
PU Version xx.xx.xx Displays the printer unit firmware version.
RAM xxMB Shows the total availability of all mounted RAM.
Flash Memory xxMB[Fxx] Displays the total availability of all flash memory and flash 

system versions installed.
HDD xx.xxGB [Fxx] Displays the HDD size and file system version installed.
Date and Time mm/dd/yyyy

        or
dd/mm/yyyy

Displays the current date and time.
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[Print Information]
Item Description

Configuration Execute Prints the device setup details.
Demo Page DEMO1 Execute Prints the demo pages.
File List Execute Prints the file list.
Usage Report *2 Execute Prints the total print results.
Error Log Execute Prints the error log.
Color Profile List Execute Prints the color profile list.
User Media List *3 Execute Prints the user media list.
Test Print-1 Execute Prints the patterns for analyzing the print quality.
Test Print-2 Execute Prints the patterns for analyzing the CMYK print 

quality.
Test Print-3 Execute Prints the patterns for analyzing the status of the 

print cartridges.
Test Print-4 *1 Execute Prints the patterns for analyzing print quality of the 

spot colors.
Cleaning Page Execute Prints the toner-free white sheet to remove dirt 

from the surface of the fuser belt in the fuser unit.
*1:  Displayed with Pro1050 only.

*2:  Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.

*3:  Displayed when the user media is registered.
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[Menus]

 �Unwinder Config
 z Shaded areas are factory-set values.

Item Value Description
Media Form*2 Continuous Paper

Continuous Paper 
(Black Mark)
Die-cut Label (Gap)
Die-cut Label (Black 
Mark)
Continuous Label
Continuous Label 
(Black Mark)

Specifies the shape of the roll paper.

Liner Width Config Liner Width 
Mode

Auto
Custom

Specifies the mode for setting the width 
of the label’s liner.
Auto: 
   The width of the liner is set given that 
the label is in the center of the liner.

Custom: 
   The width of the liner is input and the 
left gap is calculated given that the left 
and right gaps are different.

Liner Width*2 29.4 millimeter 
(1.16 inch)

～

105.6 millimeter 
(4.16 inch)
109.0 millimeter 
(4.29 inch)

～

130.0 millimeter 
(5.12 inch)

Inputs the width of the liner.
Appears when the [Liner Width Mode] is 
[Custom].

The initial values vary depending on your 
operating environment.

Right Gap*2 2.0 millimeter 
(0.08 inch)

～

25.4 millimeter 
(1.00 inch)

Specifies the distance from the right edge 
of the label to the right edge of the liner.

Paper Size*3 A6
4x6 inch
Custom

Sets the size of the paper for the 
unwinder.

The initial values vary depending on your 
operating environment.

X Dimension*3 25.4 millimeter 
(1.00 inch)

～

101.6 millimeter 
(4.00 inch)
105.0 millimeter 
(4.13 inch)

～

126.0 millimeter 
(4.96 inch)*1

Sets the width of the custom paper sizes 
for the unwinder.
Sets the dimension perpendicular to the 
paper feed direction.

The initial values vary depending on your 
operating environment.

*1:  130.0 mm (5.12 inch) if the [Media Form] is [Continuous Paper] or [Continuous Paper (Black Mark)]

*2: Changes the setting values according to the driver setting during printing.

*3: Changes the setting values according to the driver setting during printing (except for when Media Form is set to [Continuous 
Paper] in the driver setting).
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Item Value Description
Y Dimension*3 12.7 millimeter 

(0.50 inch)

～

101.6 millimeter 
(4.00 inch)

～

148.0 millimeter 
(5.83 inch)
152.4 millimeter 
(6.00 inch)

～

1320.8 millimeter 
(52.00 inch)

Sets the length of the custom paper sizes 
for the unwinder.
Sets the same direction as for the 
dimension in the paper feed direction.
If the setting is 101.6 mm (4.00 inch) or 
lower, then the set page length is handled 
as a whole-number multiple of the actual 
length of the page such that it exceeds 
101.6 mm (4.00 inch).

The initial values vary depending on your 
operating environment.
Appears when the Media Form is 
[Continuous Paper], [Die-cut Label 
(Gap)], [Die-cut Label (Black Mark)] or 
[Continuous Label].

Black Mark Interval*2 15.9 millimeter 
(0.63 inch)

～

101.6 millimeter 
(4.00 inch)

～

151.2 millimeter 
(5.95 inch)
155.6 millimeter 
(6.13 inch)

～

1324.0 millimeter 
(52.13 inch)

Sets the interval of the marks on custom 
paper for the unwinder.
Sets the same direction as for the 
dimension in the paper feed direction.
If the setting is 104.8 mm (4.13 inch) or 
lower, then the set page length is handled 
as a whole-number multiple of the actual 
length of the page such that it exceeds 
101.6 mm (4.00 inch). 
The initial values vary depending on your 
operating environment.
Appears when the Media Form is 
[Continuous Paper (Black Mark)] or 
[Continuous Label (Black Mark)].

Gap Length*2 3.0 millimeter 
(0.12 inch)

～

10.0 millimeter 
(0.39 inch)

Sets the interval for labels.
Sets the same direction as for the 
dimension in the paper feed direction.
Appears when the Media Form 
is [Die-cut Label (Gap)] or 
[Die-cut Label (Black Mark)].

Adjust Cut Position -0.5 millimeter  
(-0.02 inch)

～

0.0 millimeter 
(0.00 inch)

～

+0.5 millimeter 
(+0.02 inch)

Specifies the compensation value for 
the distance from the print completion 
position to the cut position (beginning of 
next label). (Specifies margin on following 
edge)
If you specify a negative value, cutting is 
done at a short position.

*2: Changes the setting values according to the driver setting during printing.

*3: Changes the setting values according to the driver setting during printing (except for when Media Form is set to [Continuous 
Paper] in the driver setting).

 z Shaded areas are factory-set values.
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Item Value Description
Media Type*2 Plain

Plain Labels
Glossy Labels
Film Labels1
Film Labels2
Film1
Film2
USERTYPE1*1

USERTYPE2*1

USERTYPE3*1

USERTYPE4*1

USERTYPE5*1

USERTYPE6*1

USERTYPE7*1

USERTYPE8*1

USERTYPE9*1

USERTYPE10*1

USERTYPE11*1

USERTYPE12*1

USERTYPE13*1

USERTYPE14*1

USERTYPE15*1

USERTYPE16*1

USERTYPE17*1

USERTYPE18*1

USERTYPE19*1

USERTYPE20*1

Sets the type of the paper for the 
unwinder.

Media Weight Light
Medium Light
Medium
Medium Heavy
Heavy
Ultra Heavy1
Ultra Heavy2
Ultra Heavy3

Sets the thickness of the paper for the 
unwinder.

Sensor Setting*2 Set1 : 
Set2 : 
Set3 : 
Set4 : 
Set5 : 
Set6 : 
Set7 : 
Set8 : 
Set9 : 
Set10 : 

Sets the sensitivity of the gap sensor or 
black mark sensor.
Only the adjusted sensor setting is 
displayed.

Appears when the [Media Form] is 
something other than [Continuous Paper] 
or [Continuous Label].

 z Shaded areas are factory-set values.

*1:  USERTYPE 1 to 20 are displayed when they are registered. 

*2: Changes the setting values according to the driver setting during printing.
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Item Value Description
Sensor 
Calibration

Set1 : 
Set2 : 
Set3 : 
Set4 : 
Set5 : 
Set6 : 
Set7 : 
Set8 : 
Set9 : 
Set10 : 

Execute Calibration Execute Executes calibration of the gap sensor or 
black mark sensor.

Adjust 
Slice 
Level

Reflective 
Sensor in 
Unwinder

0

～

1023

Fine tunes the sensitivity of the reflective 
sensor in the unwinder that was measured 
during Sensor Calibration.
The default value fluctuates according to 
the results of the calibration.
Appears when the black mark sensor is 
used.

Reflective 
Sensor in 
Printer

0

～

1023

Fine tunes the sensitivity of the reflective 
sensor in the device that was measured 
during Sensor Calibration.
The default value fluctuates according to 
the results of the calibration.
Appears when the black mark sensor is 
used.

Transmission 
Sensor  in 
Unwinder

0
～

1023

Fine tunes the sensitivity of the 
transmission sensor in the unwinder that 
was measured during Sensor Calibration.
The default value fluctuates according to 
the results of the calibration.
Appears when the gap sensor is used.

Transmission 
Sensor  in 
Printer

0

～

1023

Fine tunes the sensitivity of the 
transmission sensor in the device that 
was measured during Sensor Calibration.
The default value fluctuates according to 
the results of the calibration.
Appears when the gap sensor is used.

Change Name Execute You can change the name of the specified 
setting numbers.
You can use up to eight characters of 
single-byte upper case English and 
numbers.

Reset Setting Execute Initializes the content of the specified 
setting numbers.

Check Media Pitch Execute Measures the intervals on the paper.
Appears when the [Media Form] is 
something other than [Continuous Paper] 
or [Continuous Label].
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 �Cutter Setup
 z Shaded areas are factory-set values.

Item Value Description
Cut Mode Job

Collation
Specified Interval

Specifies the cutting operation.
Job: 

Cuts at the end of a job.
Collation: 

Cuts at the end of the job and at the end of the job collation.
Specified Interval: 

Cuts in units of the specified number of pages. Cuts at the end 
of the collation/job.

Cut Interval 1

～

9999

Sets how many pages are cut each time.
Appears when the [Cut Mode]  is [Specified Interval].
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 �System Adjust
 z Shaded areas are factory-set values.

Item Value Description
Power Save Time 1 minute

2 minutes
3 minutes
4 minutes
5 minutes
10 minutes
15 minutes
30 minutes
60 minutes

Sets the time until the printer enters power save 
mode.

Auto Power Off Time 1 hour
2 hours
3 hours
4 hours
8 hours
12 hours
18 hours
24 hours

Sets the time until the printer enters OFF mode 
from stand-by status.

Clearable Warning ONLINE
Job

Sets the timing until clearable warning display turns 
OFF.

Timeout InJob Off
5 seconds
10 seconds
20 seconds
30 seconds
40 seconds
50 seconds
60 seconds
90 seconds
120 seconds
150 seconds
180 seconds
210 seconds
240 seconds
270 seconds
300 seconds

Sets the time from loss of the receipt of data until 
force-printing.
With PS, the job is canceled without printing.

Timeout Local 0 seconds
5 seconds

～

40 seconds

～

290 seconds
295 seconds
300 seconds 

Sets the time for each port to be kept opened after 
printing. (Excludes network)

Timeout Network 0 seconds
5 seconds

～

90 seconds

～

290 seconds
295 seconds
300 seconds

Sets the time for the network port to be kept 
opened after printing.

Error Report On
Off

Specifies whether to print error reports when an 
internal PCL or PS error occurs.

Hex Dump Execute Prints received data in QR code.
Turn off the power to stop printing the hex dump. 
Do not use die-cut labels since media is cut to fixed 
length when the hex dump is printed.
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 �Print Adjust
 z Shaded areas are factory-set values.

Item Value Description
Print Position 
Adjust

X Adjust 0.00 millimeters
+0.1 millimeters

～

+2.00 millimeters
-2.00 millimeters

～

-0.1 millimeters

Adjusts the overall image print position perpendicularly 
(horizontally) in the direction of paper feed (0.1 mm 
intervals).

Y Adjust 0.00 millimeters
+0.1 millimeters

～

+2.00 millimeters
-2.00 millimeters

～

-0.1 millimeters

Adjusts the overall image print position in the direction of 
paper feed (vertically) (0.1 mm intervals).

Paper Edge Detect Mode Mode1
Mode2
Off

Set the action of the controls for the leading edge of the 
media to avoid image skew and detection position skew 
of the leading edge of labels.
Mode1:

For long leading edges, this setting automatically cuts/
outputs and then starts printing. For short leading 
edges, printing just starts. (Applicable for the gap/
black mark setting)

Mode2:
For short or long leading edges, this setting 
automatically cuts/outputs and then starts printing for 
both situations.
(Applicable for the gap/black mark setting if the 
leading edge is long. If the leading edge is short, then 
only the gap setting is applicable.)

Off:
With this mode, the user straightens the leading edge 
so paper is not wasted. (Applicable for the gap/black 
mark setting)

Roll Paper End Detect Mode Auto
Stop
Forced Cut

Sets the control for ejecting the trailing edge of the 
paper to auto, stop feeding, or forced cut.
Auto:

With this mode, the trailing edge is processed 
appropriately according to the media.

Stop:
With this mode, feed is forced to stop when the trailing 
edge of the paper is detected, regardless of the length 
or type of media.

Forced Cut:
With this mode, the system is forced to cut and eject 
the paper when the trailing edge of the paper is 
detected, regardless of the length or type of media.

Media Transfer Setting Black 0
+1
+2
+3
-3
-2
-1

Performs fine adjustment if black is faded or tiny white 
spots appear when printing with the black (K) print 
cartridge only (when printing with the YMCW print 
cartridges are raised).
Lower the setting value if there are only fewer white 
spots, or raise the setting value if the high-density 
portion is thinner.

Media Transfer Setting Color 0
+1
+2
+3
-3
-2
-1

Performs fine adjustment if colors are faded or tiny 
white spots appear when printing with two or more print 
cartridges or just the white (W) print cartridge.
Lower the setting value if there are only fewer white 
spots, or raise the setting value if the high-density 
portion is thinner.
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 z Shaded areas are factory-set values.

Item Value Description
SMR Setting Cyan 0

～

+3
-6

～

-1

Compensates for uneven print density due to 
temperature and humidity, and printing quantity, using 
cyan. Raise the setting value if it is blurred. Lower the 
setting value if the density darkens partially.
*  Continued use with the setting value raised has a risk 

of printing stains.
*  Continued use with the setting value lowered has a risk 

of blurring.
Magenta 0

～
+3
-6

～

-1

Compensates for uneven print density due to 
temperature and humidity, and printing quantity, using 
magenta. Raise the setting value if it is blurred. Lower 
the setting value if the density darkens partially.
*  Continued use with the setting value raised has a risk 

of printing stains.
*  Continued use with the setting value lowered has a risk 

of blurring.
Yellow 0

～

+3
-6

～

-1

Compensates for uneven print density due to 
temperature and humidity, and printing quantity, using 
yellow. Raise the setting value if it is blurred. Lower the 
setting value if the density darkens partially.
*  Continued use with the setting value raised has a risk 

of printing stains.
*  Continued use with the setting value lowered has a risk 

of blurring.
Black 0

～

+3
-6

～

-1

Compensates for uneven print density due to 
temperature and humidity, and printing quantity, using 
black. Raise the setting value if it is blurred. Lower the 
setting value if the density darkens partially.
*  Continued use with the setting value raised has a risk 

of printing stains.
*  Continued use with the setting value lowered has a risk 

of blurring.
White*1 0

～

+3
-6

～

-1

Compensates for uneven print density due to 
temperature and humidity, and printing quantity, using 
white. Raise the setting value if it is blurred. Lower the 
setting value if the density darkens partially.
*  Continued use with the setting value raised has a risk 

of printing stains.
*  Continued use with the setting value lowered has a risk 

of blurring.
*1:  Displayed with Pro1050 only.
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 z Shaded areas are factory-set values.

Item Value Description
BG Setting Cyan 0

+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences 
in the temperature and humidity, using cyan. Lower the 
setting value if the underlay is dark.
*  Continued use with the setting value lowered has a risk 

of printing stains.

Magenta 0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences 
in the temperature and humidity, using magenta. Lower 
the setting value if the underlay is dark.
*  Continued use with the setting value lowered has a risk 

of printing stains.

Yellow 0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences 
in the temperature and humidity, using yellow. Lower the 
setting value if the underlay is dark.
*  Continued use with the setting value lowered has a risk 

of printing stains.

Black 0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences 
in the temperature and humidity, using black. Lower the 
setting value if the underlay is dark.
*  Continued use with the setting value lowered has a risk 

of printing stains.

White*1 0
+1
+2
+3
-3
-2
-1

Compensates for print results variation due to differences 
in the temperature and humidity, using white. Lower the 
setting value if the underlay is dark.
*  Continued use with the setting value lowered has a risk 

of printing stains.

Drum Cleaning On
Off

Sets whether to implement drum cleaning before 
printing. The image quality may be improved.

Transfer Roller Cleaning Execute Implements cleaning of the 2nd transfer roller unit.
*1:  Displayed with Pro1050 only.
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 z Shaded areas are factory-set values.

Item Value Description
Transfer 
Setting

Cyan Transfer 
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and 
dark streaks appear for cyan, green and blue toner.
Raise the setting value if the high-density portion of 
cyan, green and blue is thinner.

Magenta Transfer 
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and 
dark streaks appear for magenta and/or red toner.
Raise the setting value if the high-density portion of 
magenta and/or red is thinner.

Yellow Transfer 
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and 
dark streaks appear for yellow toner.
Raise the setting value if the high-density portion of 
yellow is thinner.

Black Transfer 
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe white dots and 
dark streaks appear for black toner.
Raise the setting value if the high-density portion of 
black is thinner.

White Transfer 
Setting*1

0
+1
+2
+3
-3
-2
-1

Lower the setting value if lateral-stripe voids and dark 
streaks appear for white toner.
Raise the setting value if the high-density portion of 
white is thinner.

DV Roller Cleaning 1 On
Off

Adjust the toner disposal threshold.
On: 
  Image quality priority
Off: 
  Toner life priority

DV Roller Cleaning 2 Mode 1
Mode 2
Off

May be effective in reducing lateral striping caused by 
variations in ambient temperature and/or humidity. Try 
mode 2 if desired results are not produced by mode 1.

*1:  Displayed with Pro1050 only.
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[Admin Setup]

Note

 z To enter this menu, it is necessary to enter the [Password].

 z The factory default setting of the administrator password is [999999].

 �Network Setup
 z Shaded areas are factory-set values.

Item Value Description
TCP/IP Enable

Disable
Enables/disables TCP/IP protocols.

NetBIOS over TCP *1 Enable
Disable

Enables/disables NetBIOS over TCP/IP.

IP Address Set *1 Auto
Manual

Specifies whether to request the IP address 
from the DHCP server.

IPv4 Address *1 *2 xxx.xxx.xxx.
xxx

Sets the IP address.

Subnet Mask *1 *2 xxx.xxx.xxx.
xxx

Sets the subnet mask.

Gateway Address *1 *2 xxx.xxx.xxx.
xxx

Sets the gateway address.

Web *1 Enable
Disable

Enables/disables access using web browsers.

Telnet *1 Enable
Disable

Enables/disables access using Telnet.

FTP *1 Enable
Disable

Enables/disables access using FTP.

IPSec *1 Enable
Disable

Enables/disables access using IPsec.

SNMP *1 Enable
Disable

Enables/disables access using SNMP.

Network Scale Normal
Small

Normal:
Printer operates effectively even if 
connected to a hub with spanning tree 
functions. However, printer startup 
time becomes longer when two or three 
computers are connected to a small-scale 
LAN.

Small:
Covers small scale LANs with 2 or 3 PCs 
to large scale LANs are covered, but if 
connected to a hub with spanning tree 
functions, operations may not be effective.

Gigabit Network Enable
Disable

Sets whether to support a Gigabit network.

Hub Link Setting Auto Negotiate
100Base-TX Full
100Base-TX Half
10Base-T Full
10Base-T Half

Sets the connection mode to the hub.

Network Factory Defaults Execute Restores the settings, such as network, mail 
server, LDAP server, and secure protocol 
server, etc., to their default values.

*1:  Appears when [Enable] is set on the control panel for [TCP/IP].

*2: Appears when [Manual] is set on the control panel for [IP Address Set].
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 �USB Setup
 z Shaded areas are factory-set values.

Item Value Description
USB Enable

Disable
Enables/disables access using a USB interface.

Speed 480Mbps
12Mbps

Sets the maximum baud rate using a USB interface.

Soft Reset Enable
Disable

Enables/disables the software reset command.

Serial Number Enable
Disable

Enables/disables the USB serial number.
The USB serial number is used to identify USB 
devices connected to a PC.

Offline Receive Enable
Disable

Sets whether to receive data even if offline or a 
recoverable error occurs.
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 �Print Setup
 z Shaded areas are factory-set values.

Item Value Description
Personality Auto

PCL
PostScript

Select the print language. Print language switching 
is automatic when set to [Auto].

Copies 1

～

9999

Sets the copy quantity.
This setting is ignored in case of local print.
This setting is disabled unless the [Job Copy] 
setting is 1.

Job Copy 1

～

999

Sets the print quantity. 
This setting is ignored in case of local print.
The settings in the printer driver always overwrite 
these settings.   

*  This setting is enabled only if [Collate] is checked 
and 1 is specified as the number of copies in the 
PCL printer driver.

Edge to Edge On
Off

Sets the print margin.

Resolution 600dpi
1200dpi

Sets the resolution.

Toner Save Toner Save Level Off
Low
Middle
High

Set the toner save quantity.
Specifies [Off] when toner save mode is disabled.

Color All
Except 100% 
Black

All:
All colors, including 100% black, comprise all the 
target colors for toner saving.

Except 100% Black:
All colors, excluding 100% black, comprise all the 
target colors for toner saving.

Check Unnecessary Print Cartridge On
Off

Set whether to generate an error or continue 
printing when a print cartridge is detected to 
be down even though it is not being used as a 
specified color for the print data.
On:

An error is displayed and the print job is 
cancelled, to give priority to the service life of 
the print cartridge.

Off:
A warning screen is displayed, but printing 
continues because priority is given to 
productivity.

Default Orientation Portrait
Landscape

Sets the print orientation.

Trapping Off
Narrow

Narrow / 
Choke White

Wide

Wide / Choke 
White

Choke White

Sets trapping.

[Narrow/Choke White], [Wide/Choke White], and 
[Choke White] are displayed for the Pro1050 only.
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 �PS Setup
 z Shaded areas are factory-set values.

Item Value Description
Network Protocol ASCII

RAW
Specifies the PS communication protocol mode for 
data from the network.

USB Protocol ASCII
RAW

Specifies the PS communication protocol mode for 
data from USB.

 �PCL Setup
 z Shaded areas are factory-set values.

Item Value Description
Font Source Resident

Downloaded

Sets the location of the fonts to be used.

Font Number*1 I0
S1

Sets the numbers of the fonts to be used.     

Font Pitch 0.44 CPI

～

10.00 CPI

～

99.99 CPI

Sets the font width.
Increases and reduces in 0.01 CPI units.
Displayed when the font selected using [Font 
Number] is an outline font with fixed spacing.

Font Height 4.00 points

～

12.00 points

～

999.75 points

Sets the font height.
Increases and reduces in 0.25 point units.
Displayed when the font selected using [Font 
Number] is an outline font with variable spacing.

Symbol Set PC-8
PC-8 Dan/Nor
PC-8 Grk
PC-8 TK
PC-775
PC-850
PC-851 Grk
PC-852
PC-855
PC-857 TK
PC-858
PC-862 Heb
PC-866
PC-866 Ukr
PC-869
PC-1004
Pi Font
Plska Mazvia
PS Math
PS Text
Roman-8
Roman-9
Roman Ext
Serbo Croat1
Serbo Croat2
Spanish
UCS-2
Ukrainian
VN Int'l
VN Math
VN US
Win 3.0
Win 3.1 L/G
Win 3.1 Blt

Select the symbol set.

*1: Refer to “Resident Fonts” (P.71) about the Font Number to be used.
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 z Shaded areas are factory-set values.

Item Value Description
Symbol Set Win 3.1 Cyr

Win 3.1 Grk
Win 3.1 Heb
Win 3.1 L1
Win 3.1 L2
Win 3.1 L5
Wingdings
Dingbats MS
Symbol
OCR-A
OCR-B
OCRB Subset2
HP ZIP
USPSFIM
USPSSTP
USPSZIP
Bulgarian
CWI Hung
DeskTop
German
Greek-437
Greek-437 Cy
Greek-737
Greek-8
Greek-928
Hebrew NC
Hebrew OC
Hebrew-7
Hebrew-8
IBM-437
IBM-850
IBM-860
IBM-863
IBM-865
ISO Dutch
ISO L1
ISO L2
ISO L4
ISO L5
ISO L6
ISO L9
ISO Swedish1
ISO Swedish2
ISO Swedish3
ISO-2 IRV
ISO-4 UK
ISO-6 ASC
ISO-10 S/F
ISO-11 Swe
ISO-14 JASC
ISO-15 Ita
ISO-16 Por

Select the symbol set.

ISO-17 Spa
ISO-21 Ger
ISO-25 Fre
ISO-57 Chi
ISO-60 Nor
ISO-61 Nor
ISO-69 Fre
ISO-84 Por
ISO-85 Spa
ISO-Cyr
ISO-Grk
ISO-Hebrew
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 z Shaded areas are factory-set values.

Item Value Description
Symbol Set Kamenicky

Legal
Math-8
MC Text
MS Publish
PC Ext D/N
PC Ext US
PC Set1
PC Set2 D/N
PC Set2 US

Select the symbol set.

CR Function CR
CR+LF

Specifies the operation when a CR code is received.

LF Function LF
LF+CR

Specifies the operation when an LF code is 
received.

Print Margin Normal
1/5 inch
1/6 inch
1/8 inch
1/12.5 inch

Sets the area of the paper where printing is not 
possible.

True Black On
Off

Specifies whether to use mixed CMYK or black 
toner only for printing black of image data.

Pen Width Adjust On
Off

Compensates so that thin lines are visible.

 �Color Setup
 z Shaded areas are factory-set values.

Item Value Description
Ink Simulation Off

SWOP
ISO Coated
Japan

Sets the ink simulation. This setting is enabled only 
for PS language jobs.

UCR Low
Normal
High

You can select the black plate (black) amount 
during color printing.
Setting more black plate economizes on the toner 
of the other three colors.

CMY 100% Density Enable
Disable

Enables/disables 100% output for CMY 100% shade 
values.

CMYK Conversion On
Off

You can select the method of total toner quantity 
control for CMYK data. Select [Off] to disable GCR 
(Gray Component Replacement). Furthermore, this 
menu setting is disabled if using the ink simulation 
function.
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 �Panel Setup
 z Shaded areas are factory-set values.

Item Value Description
Idle Display Supplies Life 

Unwinder Config
Sets the information displayed in the standby 
screen.

Panel Brightness During Operation 5

～

31

Adjusts the brightness (backlight luminosity) of the 
control panel LCD.
The set brightness is applied during control panel 
operations.

Panel Brightness While Power Save 0

～

1

～

31

Adjusts the brightness (backlight luminosity) of the 
control panel LCD.
The set brightness is applied after the panel 
backlight timer time has elapsed from the last 
operation.

Panel Backlight Timer 10
～

30
～

300

Adjusts the time (in seconds) from the last 
operation until [Panel Brightness While Power Save] 
is applied.

 �Time Setup
 z Shaded areas are factory-set values.

Item Value Description
Date Format yyyy/mm/dd

mm/dd/yyyy
dd/mm/yyyy

Sets the date display mode.
The initial values vary depending on your
operating environment.

Time Zone -12:00

～

+0:00

～

+13:00

Sets the time difference from GMT in 15-minute 
units. If the time zone setting is changed, the 
time differences before and after the change are 
reflected in the current time.

Daylight Saving On
Off

Sets whether to display daylight saving time.
On:

Sets the current time 1 hour forward.
Off:

Sets the current time 1 hour back.
Time Setting 2000/01/01 00 :00

～

2091/12/31 23 :59

Sets the time.

 �Power Setup
 z Shaded areas are factory-set values.

Item Value Description
Power Save Enable

Disable
Enables/disables power save mode.

Auto Power Off Enable
Auto Config
Disable

Sets auto power off mode.
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 �Others Setup
 z Shaded areas are factory-set values.

Item Value Description
RAM Setup Receive Buffer Size Auto

0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the incoming buffer size that is assured by the 
local interface.

Resource Save Auto
Off
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the resource saving area size.

Storage 
Common 
Setup

Check File System Execute Implements management data (FAT information) 
recovery, and resolves mismatches between the 
actual (free) space in the file system and the free 
space displayed.

Check All Sectors Execute Recovers defective sector information on the HDD and 
file system nonconformances.

Enable Initialization No
Yes

Specifies whether or not to authorize setup changes 
associated with HDD and flash memory initialization.

Language 
Setup

Select Language Chinese
English
French
German
Italian
Japanese
Russian
Spanish

Specifies the control panel display language.

Language Initialize Execute Deletes the message files that have been downloaded.
Also, the [Select Language] setting returns to the 
factory default setting.

Job Cancel 
Setup

Cancel Key Behavior Short
Long
Off

Sets the operations when the device <CANCEL> 
button is pressed.
Short:

Hold down no longer than two seconds to cancel the 
print job.

Long:
Hold down for 2 to 5 seconds to cancel a print job.

Off:
Disables the <CANCEL> button.

Inquiry Display On
Off

Sets whether to display the enquiry screen when a 
job is canceled.

Focus Position Yes
No

Sets whether to apply [Yes] or [No] focus for selection 
in the job cancellation enquiry screen.

Display Timeout 60

～

180

～

300

Sets the display timeout value for the enquiry screen 
when a job is canceled.



- 71 -

Table of Setting Items in the Control Panel Menu Screen

 z Shaded areas are factory-set values.

Item Value Description
Media 
Operation 
Setup

Inquiry Display On
Off

Specifies the operation when the <FEED> button or 
the <UNLOAD> button is pressed.
On:

In the cases below, a confirmation screen is 
displayed before the operation is executed.
<FEED>: When the paper changes from a stand-by 
state to a through paper state
<UNLOAD/CUT>: When cut is executed

Off: 
Operation is performed without displaying a 
confirmation message.

Rewinder Distance 600 millimeter 
(24 inch)
900 millimeter 
(36 inch)
1200 millimeter 
(48 inch)

Specifies the amount to be fed when the <FEED> 
button is pressed in the stand-by state, using the 
output slot as the reference point.

Feed Distance 150 millimeter 
(6 inch)
300 millimeter 
(12 inch)
450 millimeter 
(18 inch)

Specifies the amount to be fed when the <FEED> 
button is pressed in the through paper state, using 
the current position as the reference point.

 �Settings
 z Shaded areas are factory-set values.

Item Value Description
Reset Settings Execute Restores the user menu settings to the factory 

settings.
Save Settings Execute Saves the current menu settings.
Restore Settings*1 Execute Changes the saved menu settings.

*1: Displayed when [Save Settings] is executed on the control panel.

 �Change Password
 z Shaded areas are factory-set values.

Item Value Description
New Password ************ Sets a new password to be entered in the [Admin 

menu] and [Boot Menu].
Verify Password ************ Sets a new password to be entered in the [Admin 

menu] and [Boot Menu] for which [New Password] 
has been set.

 �Resident Fonts
Item Font Name List

I0 Courier
I1 Courier Bold
I2 Courier Italic
I3 Courier Bold Italic
I4 CG Times
I5 CG Times Bold
I6 CG Times Italic
I7 CG Times Bold Italic
I8 CG Omega
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Item Font Name List
I9 CG Omega Bold
I10 CG Omega Italic
I11 CG Omega Bold Italic
I12 Coronet
I13 Clarendon Condenced
I14 Univers Medium
I15 Univers Bold
I16 Univers Medium Italic
I17 Univers Bold Italic
I18 Univers Medium Condensed
I19 Univers Bold Condensed
I20 Univers Medium Condensed Italic
I21 Univers Bold Condensed Italic
I22 Antique Olive
I23 Antique Olive Bold
I24 Antique Olive Italic
I25 Garamond Antique
I26 Garamond Halbfett
I27 Garamond Kursiv
I28 Garamond Kursiv Halbfett
I29 Marigold
I30 Albertus Medium
I31 Albertus Extra Bold
I32 Letter Gothic
I33 Letter Gothic Bold
I34 Letter Gothic Italic
I35 Arial
I36 Arial Bold
I37 Arial Italic
I38 Arial Bold Italic
I39 Times New
I40 Times New Bold
I41 Times New Italic
I42 Times New Bold Italic
I43 ITC Avant Garde Gothic Book
I44 ITC Avant Garde Gothic Demi
I45 ITC Avant Garde Gothic Book Oblique
I46 ITC Avant Garde Gothic Demi Oblique
I47 ITC Bookman Light
I48 ITC Bookman Demi
I49 ITC Bookman Light Italic
I50 ITC Bookman Demi Italic
I51 Courier PS
I52 Courier PS Bold
I53 Courier PS Oblique
I54 Courier PS Bold Oblique
I55 Helvetica
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Item Font Name List
I56 Helvetica Bold
I57 Helvetica Oblique
I58 Helvetica Bold Oblique
I59 Helvetica Narrow
I60 Helvetica Narrow Bold
I61 Helvetica Narrow Oblique
I62 Helvetica Narrow Bold Oblique
I63 New Century Schoolbook Roman
I64 New Century Schoolbook Bold
I65 New Century Schoolbook Italic
I66 New Century Schoolbook Bold Italic
I67 Palatino Roman
I68 Palatino Bold
I69 Palatino Italic
I70 Palatino Bold Italic
I71 Times Roman
I72 Times Bold
I73 Times Italic
I74 Times Bold Italic
I75 ITC Zapf Chancery Medium Italic
I76 Symbol
I77 Symbol PS
I78 Wingdings
I79 ITC Zapf Dingbats
I80 OCRB Subset2
I81 Line Printer
I82 OCR-A
I83 OCR-B
I84 USPS POSTNET Bar Codes
Scalable: 81 fonts (No.I0-80)

Bitmap: 4 fonts (No.I81-84)

Total 85 fonts
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[Print Statistics]

Note

 z To enter this menu, it is necessary to enter the [Password].

 z In the default factory settings, the password is [0000].

 z Shaded areas are factory-set values.

Item Value Description
Usage Report Enable

Disable
Enables/disables the Usage Report function.

Supplies Report*1 Enable
Disable

Sets whether or not to display the number of 
consumables replacements.

Reset Main Counter*1 Execute Resets the main counter aggregate value.
Reset Supplies Counter*2 Execute Resets the number of consumables replacements.
Change 
Password*1

New Password **** Sets the new password to be entered in [Print 
Statistics].

Verify Password **** Sets a new password to be entered in the [Print 
Statistics] for which [New Password] has been set.

*1:  Not displayed if [Disable] is set for the control panel [Print Statistics] > [Usage Report] item.

*2:  Not displayed if [Disable] is set for the control panel [Supplies Report] item.
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[Calibration]
 z Shaded areas are factory-set values.

Item Value Description
Auto Density Mode On

Off
Sets whether to automatically compensate density 
and shade.

Adjust Density Execute Implements density compensation. Implement 
when the device is in stand-by status.

Adjust Registration Execute Implements auto color misalignment compensation 
operations. Implement when the device is in stand-
by status.

Color Density Cyan Density -3

～
0

～

+3

Adjusts the cyan density.
This setting is enabled from printing after the 
density compensation has been implemented.

Magenta Density -3

～

0

～

+3

Adjusts magenta density.
This setting is enabled from printing after the 
density compensation has been implemented.

Yellow Density -3

～

0

～

+3

Adjusts yellow density.
This setting is enabled from printing after the 
density compensation has been implemented.

Black Density -3

～

0

～

+3

Adjusts black density.
This setting is enabled from printing after the 
density compensation has been implemented.

White Density*1 -3

～

0

～

+3

Adjusts white density.
This setting is enabled from printing after the 
density compensation has been implemented.

Print Color Tuning Pattern Execute Prints patterns to match the shading characteristics.
Base Color 
Tuning

Highlight A-1
A-2
B-1
B-2

～

O-1
O-2

Matches the color balance for the parts displayed as 
most clear in the highlight area of the printed color 
tuning pattern.
The matching results are reflected in the highlight 
matching values for cyan, magenta, and yellow 
matching.

Mid-Tone A-1
A-2
B-1
B-2

～

O-1
O-2

Matches the color balance for the parts displayed as 
most clear in the mid-tone area of the printed color 
tuning pattern.
The matching results are reflected in the mid-tone 
matching values for cyan, magenta, and yellow 
matching.

Dark A-1
A-2
B-1
B-2

～

O-1
O-2

Matches the color balance for the parts displayed 
as most clear in the dark area of the printed color 
tuning pattern.
The matching results are reflected in the dark 
matching values for cyan, magenta, and yellow 
matching.

*1: Displayed with Pro1050 only. 
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 z Shaded areas are factory-set values.

Item Value Description
Fine Color 
Tuning

Cyan Tuning Highlight -4

～

0

～

+4

Matches the highlights (light areas) of the cyan 
shade characteristics.

Mid-Tone -4

～

0

～

+4

Matches the intermediate areas of the cyan shading 
characteristics.

Dark -4

～
0

～

+4

Matches the dark (dark areas) of the cyan shade 
characteristics.

Magenta 
Tuning

Highlight -4

～

0

～

+4

Matches the highlights (light areas) of the magenta 
shading characteristics.

Mid-Tone -4

～

0

～

+4

Matches the intermediate areas of the magenta 
shading characteristics.

Dark -4

～

0

～

+4

Matches the dark (dark areas) of the magenta 
shading characteristics.

Yellow 
Tuning

Highlight -4

～

0

～

+4

Matches the highlights (light areas) of the yellow 
shading characteristics.

Mid-Tone -4

～

0

～

+4

Matches the intermediate areas of the yellow 
shading characteristics.

Dark -4

～

0

～

+4

Matches the dark (dark areas) of the yellow shading 
characteristics.

Black Tuning Highlight -3

～

0

～

+3

Matches the highlights (light areas) of the black 
shading characteristics.

Mid-Tone -3

～

0

～

+3

Matches the intermediate areas of the black 
shading characteristics.

Dark -3

～

0

～

+3

Matches the dark (dark areas) of the black shading 
characteristics.
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 z Shaded areas are factory-set values.

Item Value Description
Reset Color Tuning Execute Resets CMYK color matching.
White Tuning*1 Highlight -3

～

0

～

+3

Matches the highlights (light areas) of the white 
shading characteristics.

Mid-Tone -3

～

0

～

+3

Matches the intermediate areas of the white 
shading characteristics.

Dark -3
～

0

～

+3

Matches the dark (dark areas) of the white shading 
characteristics.

Density Adjustment Media Standard Media
Narrow/Thick 
Media

Specifies the operation speed during a density 
adjustment operation.
Standard Media: 
   Density adjustment operation performed at 
normal speed.

Narrow/Thick Media: 
   Density adjustment operation performed at low 
speed.

*1: Displayed with Pro1050 only.
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[Boot Menu]

Note

 z This menu is displayed in English only.

 �Boot Menu

Note

 z To enter this menu, press and hold the <OK> button while turning ON the power supply.

 z Confirm that [Boot Menu] is selected and then press the <OK> button.

 z To enter this menu, it is necessary to enter the [Password].

 z The factory default setting of the administrator password is [999999].

 z Shaded areas are factory-set values.

Item Value Description
Storage 
Common 
Setup 

Check File System Execute Executes management data (FAT information) 
recovery, and resolves mismatches between the 
actual (free) space in the file system and the 
displayed free space.

Check All Sectors Execute Recovers defective sector information on the HDD 
and file system nonconformances.

Menu Lockout On
Off

Specifies whether or not to display menus on the 
control panel.

Panel Lockout Mode1
Mode2
Off

Sets whether to disable the operations buttons on 
the control panel.

 �Troubleshooting

Note

 z To enter this menu, press and hold the <OK> button while turning ON the power supply. 

 z Select [Troubleshooting] and then press the <OK> button.

Item Value Description
Sensor Calibration Reset Execute This resets all sensor calibration results to initial 

values.
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 Saving Toner When Printing

Saving Toner When 
Printing (Toner Save 
Mode)

You can print by economizing the toner 
consumption amount by reducing the page print 
density. Separately enable or disable the toner 
economy mode for 100% black.

Memo

 z You can suppress the quantity of toner used by selecting 
one of the following five patterns as necessary to reduce 
toner density.

 - Printer setting: Follows the printer’s setup.

 - Off: Prints using regular density without economizing 
the toner.

 - Save Level Low: Prints using medium light toner.

 - Save Level Middle: Prints using light toner.

 - Save Level High: Prints using considerably light toner.

 z [Toner Saving] is enabled only if the print quality is 
specified as [Normal] or [Draft].

 z The settings on the printer can be changed from [Admin 
Setup] > [Print Setup] > [Toner Save]. However, the 
printer driver settings are given priority.

Note

 z Toner save mode is not compatible with Spot Color 
printing.

 �Windows PCL printer driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, use [Toner Saving] 
to select a toner save quantity.

5 Print.
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Printing Using the Specified Print Cartridge Only (Lift Up)
The lifespan of an unused print cartridge can be prolonged by separating it from the belt unit.

Setting combinations are shown in the table 
below.

Print Color Print Cartridge to be 
Lifted Up

Black (K) only Cyan, magenta, yellow, 
white*

White* (W) only Black, cyan, magenta, 
yellow

Black + white* Cyan, magenta, yellow
Black, cyan, magenta, 
yellow

White*

Example: Printing using the CMYK Print Cartridge 
only

In this example, the White* (W) Print Cartridge 
is lifted up.
*: Supported by Pro1050 only. 

1 Grasping the Top Cover Open Lever, 
open the Top Cover.

2 Check the position of the unused print 
cartridge via the label letters and color.

3 Turn the lift up lever on the print 
cartridge that is not being used 
clockwise to raise the print cartridge.

4 Close the top cover.

Note

 z When closing the Top Cover, there is a risk of 
pinching your fingers at the Top Cover support point 
and Top Cover. Press the top of the Top Cover to 
close it.

 z When closing the Top Cover while grasping the LED 
head, there is a risk of pinching your fingers or 
hands. Press the top of the Top Cover to close it.
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 Fine Quality Printing

Changing Print Quality 
(Resolution)

Set [Quality] by aligning to the environment in 
which it is used.

Memo

 z Selecting [Fine/Detail(1200x1200 dpi)] prints at the 
highest quality available with the printer.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Setup] tab, change the [Quality] 
setting.

5 Print.

Making Photograph 
Printing More Vivid (Photo 
Enhance)

You can print more natural and vivid images, 
such as photos, etc.

Note

 z This function can be used with Windows PCL printer 
drivers only.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Setup] tab, select [Photo 
Enhance] in the [Quality] section, and 
then click [OK].

5 Print.
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Adjusting Fine Lines
You can prevent misaligned lines being printed 
when ultra-fine lines are specified from the 
application.  
This function is normally ON.

Memo

 z Depending on the application, bar code and other intervals 
will narrow. In this case, turn OFF the function.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click [Advanced].

5 Select [Adjust ultra fine lines]. Next, 
select [Off] for [Settings], and then 
click [OK].

6 Print.

Using Printer Fonts
You can print by replacing TrueType fonts with 
printer built-in fonts.

Note

 z The font replacement function stores the document 
fonts, but font designs cannot be reproduced. If it is 
necessary to print font designs accurately, disable the font 
replacement function.

 z In some applications, the font replacement function may 
not work properly.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 Click the [Extend] tab, and then select 
[Fonts].
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5 On the "Font" screen, select the [Font 
Substitution] check box.
For this printer, this check box is selected as the 
default setting.

6 Use the [Font Substitution Table] to 
specify which printer fonts should 
replace the TrueType fonts.

7 Print.

Using Computer Fonts
You can output TrueType fonts as they appear on 
the screen.

Note

 z Print time may be longer.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click [Fonts].

5 On the "Font" screen, clear the [Font 
Substitution] check box.

 z Download as Outline Font 
Font image is created by the printer.

 z Download as Bitmap Font 
Font information is created by the printer 
driver.

6 Print.
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 Adjusting the Print Position on the Paper
You can correct the print start position vertically and horizontally on the paper by the printer settings.

Please refer to the following procedure.

Using the roll paper

Paper feed 

direction

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <2>, <2>, <0> (function 
numbers), and then press the <OK> 
button.

3 Press the scroll button  or  to select the 
item you want to adjust.

4 Press the <OK> button.

5 Press the scroll button  or  to select the 
amount of the adjustment, and then press 
the <OK> button. Confirm there is a check 
mark ( ) to the left of the selected value.

Note

 z Y represents the paper feed direction and X represents the 
orthogonal position relative to the paper feed direction.

 z Set positive [+] numbers to widen the blank space in the 
X direction, and also set positive [+] numbers to widen 
the blank space in the Y direction.

 z Readjustment might be necessary depending on the usage 
conditions (temperature, humidity, media type).

 z By eliminating the differences between printers and using 
the same settings on all the printers with this procedure, 
you can use one computer when you want to get the 
same print results on multiple printers. Refer to “Using 
the Printer Driver to Fine-tune the Print Position” (P.16) 
about setting the computer.
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Adjusting the Position 
That Printing Starts

This section explains how to better align the 
position at which printing starts for die-cut label 
paper (with black mark), continuous label (with 
black mark), and die-cut label paper.

This adjustment is unnecessary if your print jobs 
do not require accurate positioning of where 
printing starts.

1 Adjust the position that printing starts 
on the first page.

(1) After setting the size of the media, 
calibrate the sensor and execute 
Paper interval detection.

(2) In the driver’s print settings, set [To 
specify the number of pages per 
cut] in [Cut Mode] and set [1] in 
[Page(s) per cut].

Note

 z You may not be able to set [1] in [Page(s) per 
cut] if the paper on which you are printing is 
shorter than 101.6 mm. If this is the case, set 
the smallest value that you can select.

(3) Print five pieces of the media on 
which you are actually printing.

(4) Measure the distance at A or B, 
as shown in the diagram, for all 
five sheets and then calculate the 
average of these values.

(5) Calculate the difference in the 
position you want to print and the 
average value from (4).

(6) Adjust the position using [Y Adjust] 
in [Menus]>[Print Adjust]>[Print 
Position Adjust].

Gap sensor on the 
printer

B

|

Black mark sensor 
on the printer

Label 
paper

A

Liner

Printed 
matter 

Cutting off part of 
the label makes 
measuring easier.

When using a black 
mark sensor

At the point that the 
black mark intersects 
the position of the 
black mark sensor on 
the printer, measure 
the distance at A from 
the leading edge of 
the black mark to the 
printed matter on five 
sheets.

When using a gap 
sensor

At the point that 
the label intersects 
the position of the 
gap sensor on the 
printer, measure the 
distance at B from 
the leading edge 
of the label to the 
printed matter on 
five sheets.

Memo

 z About Print Position Adjust (Y Adjust) 
  Plus and minus direction for Y adjust

Direction that media is fed

If you set Y Ad-
just in the minus 
direction, the im-
age moves up

If you set Y Ad-
just in the plus 
direction, the im-
age moves down

Leading edge  
of black mark
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2 If you are actually printing more than 
two sheets consecutively, then next, do 
the following adjustment. 
(Improve the accuracy of the function 
for learning the position that printing 
starts)

(1) In the driver’s print settings, set [To 
specify the number of pages per 
cut] in [Cut Mode] and set [20] in 
[Page(s) per cut].

(2) Print 20 pieces as a test print (*). 
  *  These printouts are test prints 

for adjusting positions, so throw 
them away when you are done.

3 The adjustments are complete when 
printing is done in the position you 
want.

Reset the cutter settings, and then start 
printing.
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 Other Print Functions

Specifying the Page Order
Extracts by page order when printing documents 
with multiple pages.

There are two methods.

 z Printing documents in page order.

 z Printing documents in reverse page order.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Setup] tab, select the [Print in 
reverse order] check box in the [Copies] 
area.

5 Print.

Overlaying Stamps for 
Printing (Watermarks)

The details to be printed from the application can 
be independently printed overlaying [Samples], 
[Confidential], etc.

Samples

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click 
[Watermarks].
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5 Click [New].

6 On the "Watermarks" screen, enter text 
into [Text], and configure [Size] and 
other settings.

7 Click the <OK> button.

8 Print.

Collating Printed Output 
(Sorted Printing)

You can store print jobs in the device memory 
and collate the printing.

1
2
3

1
2
3

1
2
3

1
2
3

3

2
3

1
1
2

Printing by specifying batches

Printing without specifying batches

x 2 sets

x 2 sets

Note

 z Not usable with some applications.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Setup] tab, enter a value for 
[Copies], and then select the [Collate] 
check box.

5 Print.
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Printing a Mirror Image
Print using mirror print when you want to print 
image to appear normal when the page is viewed 
from the back.

 �Windows PCL Printer Driver

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printer Properties].

4 Select [General] tab, and then click 
[Preferences].

5 On the [Setup] tab, select the [Mirror 
Print] check box in the [Orientation] 
section, and then click [OK].

6 Open the file to be printed.

7 Select [Page Setup] in the [File] menu.

8 Select the paper size and print 
orientation, and then click [OK].

9 Select [Print] in the [File] menu.

10 Click [OK] to return to the "Print" 
screen.

11 Click [Print] in the "Print" screen to 
print.
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Printing Registered Forms 
(Print Overlay)

You can register forms, logos, etc., as forms to 
the device, and overlay for printing.

Memo

 z To print an overlay, you need to create a form and register 
it in advance.It is possible to specify a maximum of four 
forms in one group.Forms are overlaid and printed in the 
order they are registered. That is to say, the last form you 
register is printed on top.

 �Windows PCL Printer Driver

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 Click the [Overlays] tab.

5 On the [Overlays] tab, select [Register 
print document as a new form].

Memo

 z If the form you want to print is already registered to 
the device, you do not need to do steps 5 through 10. 
Advance to step 11 of this procedure.

6 Click [Apply] > [OK] to close the 
“Printing Preferences” screen.

7 From the application, print the image 
you want to register as a form.

8 Confirm that the [New Form] screen 
appears.
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9 Input the [Form name] and [ID], and 
then click [OK].

10 The form is sent to the device and 
registered with the specified ID.

11 On the [Overlays] tab, select [Overlay 
Print].

12 Select the forms you want to use for 
overlay printing.

13 Perform the following operation to 
close the “Printing Preferences” screen: 
[Apply] > [OK].

14 Print from the application.
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Outputting to a File 
Without Printing

You can write and save to a file without printing 
the print data.

Note

 z PC administrator privileges are required.

 �Windows PCL Printer Driver

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printer Properties].

4 Select the [Ports] tab.

5 In the ports list, select [FILE:], and 
then click [OK].

6 Print.

7 Enter the file name, and then click [OK].

Changing the Check 
Unnecessary Print 
Cartridge Setting

You can have an error displayed and cancel 
the print job to prioritize the service life of a 
print cartridge that is detected to be down even 
though it is not being used as a specified color 
for the print data. 

1 Press the scroll button  or .

2 Select [Admin Setup], and then press 
the <OK> button.

3 Enter the administrator password, and 
then press the <OK> button.

Memo

 z The factory default setting of the administrator 
password is [999999].
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4 Select [Print Setup], and then press the 
<OK> button.

5 Select [Check Unnecessary Print 
Cartridge], and then press the <OK> 
button.

6 If you want an error to be generated 
when a print cartridge is detected to be 
down even though it is not being used 
as a specified color for the print data, 
select [On]. Select [Off] if you want 
printing to continue. Then, press the 
<OK> button.

7 Press the <ON LINE> button to return 
to the standby screen.

Saving Printer Driver 
Setups

You can save the details set using the printer 
drivers.

If you save the changes to the settings for 
multiple locations, then the next and following 
times you change the settings, all you have 
to do is specify the driver settings so that 
those settings in the multiple locations are 
automatically changed to the settings that you 
saved.

Save a Setup

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 Change the settings to create the setup 
you want to save.

5 On the [Setup] tab, click [Save].
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6 Enter the setting name into [Save 
Favorites as], and then click [OK].

7 Click [OK] to close the Print Setup 
dialog box.

Recall a Saved Setup

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

4 On the [Setup] tab, configure 
[Favorites].

5 Print.

Delete a Saved Setup

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [Management].

5 Click [Delete].

6 Select the setup you want to delete, 
and then click [Delete].

7 Click [Yes].
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Importing/Exporting a 
Printer Driver Print Setup

You can convert printer driver print setup 
information to a file, and then export/import the 
file. The file extension for exporting/importing is 
".xmn".

Export a Setup

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [Management].

5 Click [Export].

6 In the [List of favorite settings] on the 
"Export" screen, select the checkbox 
next to the setup you want to export, 
and then click [Export].

7 Enter a file name, specify where to save 
it, and then click [Save].

Import a Setup

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 On the [Setup] tab, click [Management].
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5 Click [Import].

6 On the "Import" screen, click [Open the 
file].

7 Specify the file you want to import, and 
then click [Open].

8 Check the names of the settings in the 
[List of favorite settings], and then click 
[Import].

9 When the message "Imported 
successfully." appears, click [OK].

Changing Default Printer 
Driver Settings

It is convenient to set frequently used settings 
as the default settings.

 �Windows PCL Printer Driver

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printing preferences].

4 Change the various settings, and then 
click [OK].
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Deleting a Printer Driver

 �Windows PCL Printer Driver

Note

 z PC administrator privileges are required.

 z Restart the computer, and then delete the driver.

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Remove device].

4 If a verification message is displayed, 
click [Yes].

Note

 z If a message appears while the device is in use, 
restart the PC, and then perform steps 1 and 2 of 
this procedure again.

5 Select one of the icons in [Devices 
and Printers], and click [Print server 
properties] in the top bar.

6 Select the [Drivers] tab.

7 Click if [Change Driver Settings] is 
displayed.

8 Select the driver to be deleted, and 
click [Remove].

9 If a message asking whether to delete 
the drivers only, or the drivers and 
packages from the system, select to 
delete drivers and packages, and click 
[OK].

10 If a verification message is displayed, 
click [Yes].

11 If the [Remove Driver Package] dialog 
box is displayed, click [Delete]>[OK].

Note

 z If you cannot cancel, restart the PC, and then 
perform steps 4 to 10 of this procedure again.

12 Click [OK] in the [Print server 
properties] dialog box.
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13 Restart the PC. 

Note

 z Network Extension and the Color Swatch Utility installed 
together with the printer driver are not deleted even if the 
printer driver is deleted.  
To delete Network Extension and the Color Swatch Utility, 
use [Control Panel] > [Uninstall a program].

Updating a Printer Driver
For information about the latest driver versions, 
check the website.

 �Windows PCL Printer Driver

Note

 z PC administrator privileges are required.

1 Download the printer driver from the 
website.

2 Double-click the file you downloaded.

3 Select the desired language, and then 
click [OK].

Memo

 z When the "User Account Control" window is 
displayed, click [Yes].

4 Read the "Software License Agreement", 
and click [Accept].

5 Follow the instructions that appear on 
the screen to finish driver installation.

Memo

 z Attempting to install an old version driver will cause 
an update screen to appear. Follow the instructions 
that appear on the screen.

 z Updating a driver may require restarting of the 
computer.

6 When the [Program Compatibility 
Assistant] dialog appears, click [This 
program installed correctly].
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Correcting Color Drift 
Manually

The printer compensates color drift automatically 
according to the conditions of use. If the color 
drift is noticeable, you can also implement 
compensation manually.

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <3>, <0>, <1>, and press the 
<OK> button.

3 Check that [Execute] has been selected, 
and press the <OK> button.

4 The display will return to the standby 
screen.

Configuring Settings 
for Auto Adjustment of 
Density and Gradation

The printer compensates density automatically 
according to the conditions of use. To 
compensate automatically, turn [On] the density 
compensation matching setting.

In the default factory settings, density 
compensation matching is implemented 
automatically.

1 Press the scroll button  or .

2 Select [Calibration], and press the 
<OK> button.

3 Select [Auto Density Mode], and then 
press the <OK> button.
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4 Select [On], and then press the <OK> 
button. Confirm there is a check mark 
( ) to the left of [On].

5 Press the <ON LINE> button to return 
to the standby screen.

Adjusting Density 
Manually

The printer can implement compensation 
periodically using auto density compensation 
mode, but if the print density is noticeable, it 
can also be compensated manually.

Memo

 z Density adjustment values are set by specifying [Cyan 
Density], [Magenta Density], [Yellow Density], [Black 
Density], and [White Density]* values with the control 
panel.

*: This item available only on the Pro1050

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <3>, <0>, <0>, and press the 
<OK> button.

3 Check that [Execute] has been selected, 
and press the <OK> button.

4 Execute density adjustment.
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5 The display will return to the standby 
screen after density adjustment is 
complete.

Fine Tuning Density 
Adjustments

You can finely adjust the densities of colors 
that are used as the references for density 
compensation.

Adjust each color separately for the parts where 
the density is noticeable from the print results.

This section describes the procedure for 
adjusting the reference density for cyan. Use the 
same adjustment procedure also for other colors 
that you wish to adjust.

 z Increasing cyan after checking the print 
results

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <3>, <1>, <0>, and press the 
<OK> button.

Memo

 z For magenta, yellow, black, and white*, use the 
operations below.

 - To tune magenta, press the <Fn> key, and then 
press the following buttons: <3>, <1>, <1>, 
<OK>.

 - To tune yellow, press the <Fn> key, and then 
press the following buttons: <3>, <1>, <2>, 
<OK>.

 - To tune black, press the <Fn> key, and then press 
the following buttons: <3>, <1>, <3>, <OK>.

 - To tune white*, press the <Fn> key, and then 
press the following buttons: <3>, <1>, <4>, 
<OK>.

*: Can be adjusted on the Pro1050 only
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3 Press the scroll button  or  to specify 
a value that is larger than the current 
value, and then press the <OK> button.

Confirm there is a checkmark ( ) to 
the left of the selected value.

Memo

 z Select +1 to +3 to make density darker, or -1 to -3 
to make it lighter.

4 Press the <ON LINE> button to return 
to the standby screen.

5 Press the <Fn> key, and then press 
<3>, <0>, <0>, <OK>.

6 Check that [Execute] has been selected, 
and press the <OK> button.

7 The display will return to the standby 
screen.

8 Print.

If you are not satisfied with the density, 
repeat steps 1 to 6 of this procedure.
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Adjusting Color Balance 
(Density)

The printer can implement compensation 
periodically using auto density compensation 
mode. However, you can implement this 
adjustment when you want to adjust the gray 
balance of the halftones, which is not sufficiently 
adjusted by the auto density compensation.

Note

 z The densities of the colors are mutually dependent on 
each other, so you will need to repeat adjustment several 
times until the desired color balance is achieved.

 z The results of the basic [Base Color Tuning] are reflected 
in the settings in [Fine Color Tuning]. Consequently, if the 
[Fine Color Tuning] are adjusted manually, these settings 
will be reset, so be careful. However, the [Black Tuning] 
settings are not reset. 

1 Print a color tuning pattern.

(1) Press the <Fn> key.
The numerical values input screen 
will be displayed.

(2) Press <3>, <0>, <2>, and press 
the <OK> button.

(3) Check that [Execute] has been 
selected, and press the <OK> 
button.

(4) The color tuning pattern will be printed.

2 Use the print results for the color tuning 
pattern to check the current color 
balance.

(1) Check the area to be referenced 
using “Base Color Tuning”. 
Check the numbers (A1,2 to O-1,2) 
of the pattern that seems the 
most similar to the adjacent CMY 
mixed colors part and single color 
K part from among the patterns 
distributed in the “Highlight”, 
“Mid-Tone”, or “Dark” areas.

Memo

 z If the pattern that seems most similar to the 
adjacent CMY mixed colors part and single color K 
part in the “Highlight”, “Mid-Tone”, or “Dark” areas 
matches the “Current” on the left of the color tuning 
pattern, the color balance is normal and does not 
require adjustment.

3 Use the print results for the color tuning 
pattern to adjust the color balance.

(1) Press the scroll button  or .
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(2) Select [Calibration], and press the 
<OK> button.

(3) Select [Base Color Tuning], and 
press the <OK> button.

(4) Specify the number of the desired 
square in the "Highlight" area of 
the pattern, and then press the 
<OK> button.

(5) Specify the number of the desired 
square in the "Mid-Tone" area of 
the pattern, and then press the 
<OK> button.

(6) Specify the number of the desired 
square in the "Dark" area of the 
pattern, and then press the <OK> 
button.

(7) The pattern number specified in 
each area will be displayed.
If the pattern number is correct, 
select [Yes], and press the <OK> 
button.

Memo

 z To respecify the pattern number select [No] to 
return to the "Calibration" screen.

(8) Select [Return], and press the 
<OK> button to return to the 
standby screen.

Memo

 z If the desired color balance is not obtained even 
after [Base Color Tuning], adjust the CMY color 
balance manually using the procedure under 
[Adjusting the color balance]. For color balance 
fine tuning, see “Fine-tuning Color Balance” 
(P.106).

 z If the overall tone is still too bright or too dark 
even after implementing [Base Color Tuning], 
adjust the black tone manually using [Fine 
Color Tuning], and then implement [Basic color 
Tuning] again. To brighten the overall tone, 
adjust the black tone in [Fine Color Tuning] in 
the - direction, and to darken the overall tone, 
adjust the black tone in [Fine Color Tuning] in 
the + direction.
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4 Check the color balance adjustment 
results.

(1) Print the color tuning pattern.

(2) Use the print results for the 
color tuning pattern to check the 
adjusted results.
If the pattern that seems most 
similar to the adjacent CMY mixed 
colors part and single color K part 
in the “Highlight”, “Mid-Tone”, 
or “Dark” areas matches the 
“Current” on the left of the color 
tuning pattern, the color balance 
adjustment is complete.
Repeat steps 1 through 3 of this 
procedure in accordance with the 
results of your pattern check.

Fine-tuning Color Balance
The printer can implement compensation 
periodically using auto density compensation 
mode. However, you can implement this 
adjustment when you want to finely adjust 
the gray balance of the halftones, which is 
not sufficiently adjusted by the auto density 
compensation.

Note

 z The densities of the colors are mutually dependent on 
each other, so you will need to repeat adjustment several 
times until the desired color balance is achieved.

1 Print a color tuning pattern.

(1) Press the <Fn> key.
The numerical values input screen 
will be displayed.

(2) Press <3>, <0>, <2>, and press 
the <OK> button.

(3) Check that [Execute] has been 
selected, and press the <OK> 
button.

(4) The color tuning pattern will be 
printed.
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2 Use the print results for the color tuning 
pattern to check the current color 
balance.

(1) Check the area to be referenced 
using "Fine Color Tuning".
The color tuning pattern blocks 
are arranged in four rows of 11 
columns. The four rows are printed 
with the following colors, from top 
to bottom: [Cyan], [Magenta], 
[Yellow] and [Black].
The 11 columns represent color 
tone, and vertical broken lines are 
labeled as [Highlight], [Mid-Tone], 
and [Dark].

3 Use the print results for the color tuning 
pattern to adjust the color balance.

If you are adjusting the color balance, 
use the control panel to specify the 
shade (Highlight, Dark, and Mid-Tone) 
of each color.
This section explains the procedure for 
slightly darkening the cyan highlights. 
Adjust the colors other than cyan in the 
same way.

(1) Press the scroll button  or .

(2) Select [Calibration], and press the 
<OK> button.

(3) Select [Fine Color Tuning], and 
press the <OK> button.

(4) Select [Cyan Tuning], and press 
the <OK> button.
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(5) Select [Highlight], and press the 
<OK> button.

(6) Specify a larger value than the 
current set value, and press the 
<OK> button. Confirm there is a 
check mark ( ) to the left of the 
specified value.

Memo

 z Select +0.1 to +4.0 to make density slightly 
darker, or -0.1 to -4.0 to make it slightly lighter. 
Note, however, that the black adjustment ranges 
are +0.1 to +3.0 and -0.1 to -3.0.

(7) Press the <ON LINE> button to 
return to the standby screen.

4 Check the color balance adjustment 
results.

(1) Print the color tuning pattern.

(2) Use the print results for the 
color tuning pattern to check the 
adjusted results.

Repeat steps 1 through 3 of this 
procedure in accordance with the 
results of your pattern check.
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Color Matching

What Is Color Matching?

It is important to manage the work processes 
from data creation to output based on methods 
with color consistency. For example, scanners, 
digital cameras, and monitors, and other devices 
express the blending ratio to which the light of 
red, blue, and green (three colors) have been 
added to black as values over the RGB color 
space (additive mixture of colors).

Meanwhile, printers express the blending ratio 
of the four toner colors cyan, magenta, yellow, 
and black relative to white (white light), with 
the three reflected colors red, blue, and green 
excluded as values in the CMYK color space 
(subtractive mixture of colors).

The RGB color space and CMYK color space are 
color spaces dependent on the machine used, 
and so when converting color spaces, the colors 
will be different from the reproduced colors 
unless individual machine characteristics are 
taken into consideration.

To maintain color consistency from data creation 
to output, it is necessary to consider the color 
differences by device when converting colors. 
This process is called "color matching". The 
program that implements the color matching is 
called the "color management system" (CMS).

The printer can use either printer driver color 
matching or application color matching.

Note

 z Even if you are using color matching, the printed colors 
may appear dark compared to the colors on the monitor. 
This is because the range of colors that can be reproduced 
by the device is narrower than the range of colors that 
can be reproduced by the monitor, so even if color 
matching is used, the vivid colors on the monitor cannot 
be reproduced.

Color Matching 
(Automatic)

The procedure below performs recommended 
color matching for general documents. Generally 
use the settings shown here.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

4 In "Color" on the [Color] tab, select 
[Automatic], and then click [OK].

5 Print.
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Simple Color Matching 
(Simple Adjustment)

Color matching is used on a printer for 
reproduction of the RGB colors required to print 
from word processor, spreadsheet, presentation, 
and other similar software.

Color matching is implemented using a special 
accelerator (ASIC) that is built into the printer. 
When converting RGB color space print data to 
the printer CMYK color space, color matching 
processing is applied.

Note

 z In the case of a Windows PCL printer driver, color 
matching is not applied even if [Automatic] or [Simple 
Adjustment] is selected for the CMYK color space print 
data. In this case, select "Graphic Pro".

 z If you are installing ICC profile in Windows, click [Advanced 
Setup] in the [Layout] tab, and then select [Disable ICM] 
in [ICM Methods].

 �Setup Items
 z [RGB Color Setting]

Specifies the method for expressing the 
colors processed using color matching.

 z Monitor - Auto
During color matching, represents 
color by the most ideal method 
suited to the document to be printed, 
emphasizing compatibility with the 
monitor (color temperature 6500 K). 
Normally use this setting.

 z Monitor - Perceptual
During color matching, represents the 
color by the method emphasizing the 
gradation suiting the natural image 
of the photograph and compatibility 
with the monitor (color temperature 
6500K).

 z Monitor - Vivid
During color matching, represents the 
color by the method emphasizing the 
vividness suiting the images and text, 
and compatibility with the monitor 
(color temperature 6500K).

 z Monitor - light
During color matching, represents the 
color by the method emphasizing the 
gradation suiting the natural image 
of the photograph and compatibility 
with the monitor (color temperature 
9300K).

 z Adobe RGB
Specify if you are using an input device 
with AdobeRGB color characteristics.

 z sRGB
The sRGB colors within the printer's 
color gamut are printed without any 
modification. Only colors that fall 
outside the printer's color gamut are 
matched with the outer shell. Suitable 
for matching specific colors.

 z [Black Finish]
Sets the black finish when printing in color. 
Normally use Auto as is.
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 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, click [Color], select 
[Automatic] or [Simple Adjustment], 
and then click [OK].

5 Print.

Color Matching 
(Graphic Pro)

Graphic Pro is the optimal choice for use with 
DTP software.

It lets you specify simulation printing for any 
CMYK output device.

To use an ICC profile of an I/O device for color 
matching, you need to register the ICC profile to 
the device beforehand.

For information about how to register an ICC 
profile, see “Registering an ICC Profile” (P.187).

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, click [Color], then 
select [Graphic Pro], and then click 
[OK].

5 Print.
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Color Matching  
(No Color Matching)

Prints using the specified colors as is, without 
implementing color matching using the printer 
drivers or device.

Select if implementing color matching using an 
application.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, click [Color], then 
select [No Color Matching], and then 
click [OK].

5 Print.

Changing the Black Finish
The finish for the black parts will be changed 
when printing in color. This can be used when 
the printer driver's color mode setting is [Simple 
Adjustment] or [Graphic Pro].

 �Setup Items
 z Black Finish

 z Auto
Creates black using the optimum 
methods according to the document to 
be printed. This setting can be selected 
only when the color mode is set to 
[Simple Adjustment]. This setting 
cannot be configured on the Graphic 
Pro.

 z Composite Black(CMYK)
Synthesizes black using cyan, 
magenta, yellow, and black toner. 
The black is close to brown. Ideal for 
photos.

 z True Black (K)
Prints black using black toner only. 
Ideal for diagrams and documents. 
When printing photos, the dark parts 
are blackish.

 z Pure Black Text/Graphics (Graphic Pro Only)
If black defined using the RGB color space 
for text and graphics (R=0, G=0, B=0) or 
black defined using the CMYK color space 
(C=0, M=0, Y=0, K=100%) is specified, 
this setting specifies whether printing 
should use black (K) toner only.

 z ON
Prints the text and graphics specified 
as black using black (K) toner only.

 z OFF
Text and graphics specified as black 
are synthesized using either black (K) 
toner only or CMYK depending on the 
profile specified by color matching.
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 �Windows PCL Printer Driver

1 Open the file to be printed.

2 On the [File] menu, select [Print].

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, select [Simple 
Adjustment] or [Graphic Pro], and then 
click [Detail].

5 In the [Black Finish] section, select the 
black finishing method. In the [Graphic 
Pro] mode, also select ON or OFF for 
[Pure Black Text/Graphics], and then 
click [OK].

6 Print.

Monochrome  
(Black and White) Printing

The color data is printed using grayscale (shades 
of black and white) without touching the print 
data.

Note

 z If implementing color printing after printing by specifying 
"Monochrome", a delay may occur depending on the 
temperature adjustment of the fuser unit.

Memo

 z Even if the cyan (blue), magenta (red), yellow print 
cartridge life has been reached, monochrome printing 
using only black can be done by specifying “Monochrome”.

 z Refer to “Printing Using the Specified Print Cartridge Only 
(Lift Up)” (P.80) regarding printing with black only.

 z For information about roll paper, see “Roll Paper 
Specifications” (P.12).

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, select [Monochrome].  
Adjust lightness and darkness as 
required.

5 Print.
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Suppressing White Lines 
Between Text and the 
Background  
(Black Overprint)

If you are imaging 100% black text on a colored 
background, you can print (overprint) by 
overlaying the text and background parts. Set if 
there are gaps such as white lines, etc., in the 
borders between the text and background.

Note

 z Not usable with some applications.

 z Black overprint cannot be used if the text is not 100% 
black, the text has been rendered as graphics by 
extracting the outlines, or if the text is an image.

 z If the background color is dark (toner layer thickness 
exceeds 240%), toner may not be fixed completely. For 
example, if printing 100% black text on backgrounds of 
50% cyan, 50% magenta, and 50% yellow, the toner 
layer thickness is 50+50+50+100=250%, which exceeds 
240%.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click [Advanced].

5 Select [Overprint Black]. Next, for 
[Settings], select [On], and then click 
[OK].

6 Print.

Correcting for Print 
Misalignment (Trapping)

Use if there are white or colored lines 
between two overlapping objects due to print 
misalignment.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Extend] tab, click [Advanced].

5 Select [Trapping]. Next, select the 
misalignment correction method with 
[Settings], and then click [OK].

Memo

 z Selections that include [Choke White] are only 
shown for the Pro1050.

6 Print.
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Adjusting Color with a Printer Driver

Simulating Print Results
The printer adjusts CMYK color data to simulate 
the characteristics of ink, such as that used in 
offset printing.

The ICC profiles registered as standard are 
described below.

 z RGB Profiles

 - sRGB

 - AdobeRGB

 z CMYK Input Profiles

 - SWOP

 - ISO Coated

 - Japan Color

 - JMPA

Note

 z Enabled when [Color Mode] is set to either [Simple 
Adjustment] or [Graphic Pro].

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Print] in the [File] menu.

3 Click [Preferences] (or [Properties]).

4 On the [Color] tab, click [Detail], and 
then select [Graphic Pro].

5 Select [Printer Simulation], and then 
use the list under [Simulation Target 
Profile] to select the ink characteristics 
you want to simulate.

6 Click [OK].

7 Print.
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Adjusting Color with a Printer Driver
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5 
Spot Color Printing 

Setup (Pro1050 Only)

Printer Driver Spot Color  
Function List ……………………………… 118

Printing on Color Papers ……………… 119

Fine-Tuning White Shading ………… 121

Note

 z The examples in this chapter use Windows WordPad for explanations. Depending on the 
application, the screens and operations procedures may differ.

 z Spot color printing is supported by the Pro1050 only.

 z For detailed explanations of the printer driver and utility setup items, see "Online Help".

 z Due to printer driver and utility version upgrades, actual operations may be different from the 
descriptions in this manual.
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Printer Driver Spot Color Function List

 Printer Driver Spot Color Function List
This section explains the Spot Color toner functions in the printer drivers.

 �Windows PCL Printer Driver
Click the [Color] tab to display the screen for setting the spot color toner.

Item Description
Usage Method Do not use Prints without using white toner.

Full page Uses white toner for the entire page being printed.
Data portion (Excluding white) Uses white toner for all data parts that do not include 

white parts.
Data portion (Including white) Uses white toner for all data parts that include white 

parts.
Printing only spot color toner Prints with white toner only.
Watermarks/Overlays Prints the selected watermark and overlay with white 

toner.
Spot color 
toner quantity 
adjustment

0 to 100 Adjusts the amount of white toner used while printing.
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Printing on Color Papers

 Printing on Color Papers

Usable Color Papers
Use color paper that satisfies the following 
conditions.

 z Pigment or ink used to color the paper heat-
resistant to 230ºC

 z E-photo printer paper with the same paper 
characteristics as plain paper

Printing Using White Toner 
Only

Printing text and illustrations using only white 
toner on color paper.

Before printing, check that the white print 
cartridge has been mounted to the device, and 
that white toner has been selected using the 
printer drivers.

Memo

 z If you specify "Print Only with Spot Color" and lift up all 
the other colors of cartridges, you can print with only spot 
colors, even if one of the black, cyan, magenta, or yellow 
print cartridges has reached the end of its service life.
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Printing on Color Papers

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Page Setup] in the [File] menu.

3 Select the paper size and print 
orientation, and then click [OK].

4 Select [Print] in the [File] menu.

5 Click [Preferences] (or [Properties]).

6 Use [Media Type] to select the paper 
type.

7 Use [Media Weight] to select an 
appropriate value.

8 Click the [Color] tab.

9 For [Usage Methods], select [Printing 
only spot color toner], and then click 
[OK].

10 Click [Print] in the "Print" screen to 
print.

Printing White Under Color
When printing on color paper, print a base with 
white toner, and then print in color on top of 
that.

 �Windows PCL Printer Driver

1 Open the file to be printed.

2 Select [Page Setup] in the [File] menu.

3 Select the paper size and print 
orientation, and then click [OK].

4 Select [Print] in the [File] menu.

5 Click [Preferences] (or [Properties]).

6 Use [Paper settings] to select the paper 
type.

7 Click the [Color] tab.

8 For the [Spot Color] setting, select 
one of the following: [Full page], 
[Data portion (Excluding white)], 
[Data portion (Including white)], or 
[Watermarks/Overlays].

9 Click [OK].

10 Click [Print] in the "Print" screen to 
print.
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Fine-Tuning White Shading

 Fine-Tuning White Shading
Finely adjust the shade for each white highlight, dark, mid-tone gradation using the printer control 
panel.

Here, we will show the procedure for slightly 
darkening white highlights.

1 Press the scroll button  or .

2 Select [Calibration], and press the 
<OK> button.

3 Select [White Tuning], and then press 
the <OK> button.

4 Select [Highlight], and press the <OK> 
button.

5 Specify a value that is larger than the 
current set value, and then press the 
<OK> button. Confirm there is a check 
mark ( ) to the left of the specified 
value.

Memo

 z A larger value represents darkening, while a smaller value 
represents lightening.

6 Press the <ON LINE> button to return 
to the standby screen.
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6 
Network Settings

Initializing Network Settings ……… 124

Using DHCP ……………………………… 125

IPv6 ………………………………………… 127
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Initializing Network Settings

 Initializing Network Settings

Note

 z Implementing this operation will initialize all network 
settings.

1 Press the scroll button  or .

2 Select [Admin Setup], and then press 
the <OK> button.

3 Enter the administrator password, and 
then press the <OK> button.

Memo

 z The factory default setting of the administrator 
password is [999999].

4 Select [Network Setup], and then press 
the <OK> button.

5 Select [Network Factory Defaults], and 
then press the <OK> button.

6 When [Execute] appears, press the 
<OK> button.

7 Initialization is executed, and the 
display returns to the standby screen.
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Using DHCP

 Using DHCP
IP addresses can be acquired from a DHCP server.

Note

 z PC administrator privileges are required for the setup.

 z Incorrectly allocating the IP address may cause major malfunctions such as crashing of the network. Thoroughly consult the 
network administrator before making the settings.

To use the device in a DHCP environment, select 
[Auto] as the IP address setting method.

Also note that [Auto] is the IP address setting 
method under factory default settings, so 
performing this procedure is normally not 
necessary.

1 Press the scroll button  or .

2 Select [Admin Setup], and then press 
the <OK> button.

3 Enter the administrator password, and 
then press the <OK> button.

Memo

 z The factory default setting of the administrator 
password is [999999].

4 Select [Network Setup], and then press 
the <OK> button.

5 Select [IP Address Set], and then press 
the <OK> button.

6 Select [Auto], and then press the <OK> 
button.

7 Press the <ON LINE> button to return 
to the standby screen.
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Using DHCP

 �To use the printer in a BOOTP 
environment

To use the printer in a BOOTP environment, 
select [BOOTP] as the IP address setting 
method.

1 Access the printer web page and log in 
as an administrator.

2 Select [Admin Setup].

3 Select [Network Setup] > [TCP/IP] > 
[Change Settings] > [Get IP address 
automatically (BOOTP)].

4 Click [Submit].

Memo

 z Refer to “Using a Web Browser to Configure the Network 
Setup” (P.153) regarding the printer web page.



- 127 -

IPv6

 IPv6
This printer is compatible with IPv6, and the 
IPv6 address is acquired automatically. IPv6 
addresses cannot be set manually.

The device is compatible with the following 
protocols.

 z Printing:

 - LPR

 - IPP

 - RAW (Port9100)

 - FTP

 z Setup:

 - HTTP

 - SNMPv1/v3

 - Telnet

Checking the IPv6 Address
IPv6 addresses are allocated automatically.

1 Access the printer web page and select 
[View information].

Memo

 z Refer to “Using a Web Browser to Configure the 
Network Setup” (P.153) regarding the printer web 
page.

2 Select [Network] > [TCP/IP].

Memo

 z If all the global addresses are displayed as "0", it is 
possible an error has occurred in the router being used.

Reference

 z Press the scroll button  or , and then select [Print 

Information] > [Configuration] to check the IPv6 address 
using the configuration report. For reports and information 
about how to print them, see “Printing Configuration 
Information” (P.130).
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7 
Viewing Machine 

Information
Printing Configuration  
Information ……………………………… 130

Checking the Print Count …………… 138



- 130 -

Printing Configuration Information

 Printing Configuration Information

Printable Report List

List Name Description Reference 
pages

Configuration Prints the table of all menu category items and the current 
settings. Further, the advanced printer settings are also printed 
in the page header.

Page 131

Demo Page Prints the demo print data stored in the printer. Page 132

File List Prints the file list. Page 52

Usage Report Prints the total print results. Page 133

Error Log Prints the errors detected and saved by the printer. Page 133

Color Profile List Prints the color profile list. Page 134

Color Adjustment Pattern Prints the patterns to match the shading characteristics. Page 104
Page 106

User Media List Prints the user media list. Page 135

Test Print-1 Prints the patterns for analyzing the print quality. Page 135

Test Print-2 Prints the patterns for analyzing CYMK print quality. Page 135

Test Print-3 Prints the patterns for analyzing  the status of the print 
cartridges.

Page 135

Test Print-4 *1 Prints the patterns for analyzing print quality of the spot colors. Page 135

Cleaning Page Prints the toner-free white sheet to remove dirt from the surface 
of the fuser belt in the fuser unit.

Maintenance 
Guide

*1:  Displayed with Pro1050 only.

 z Paper is cut at a fixed length when printing a report, so do not use die-cut label paper.

 z To attain the full benefit of the report printing function, load paper that is 130 mm wide.

 z Printing is canceled if a print cartridge for a color that is required for report printing is not lifted down.
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Printing Configuration Information

Printing Printer Setup Lists

Configuration

Print the device information.

Print to see the remaining quantity of 
consumables and other set values such as IP 
addresses and MAC addresses, and to check 
whether the printer is operating correctly, etc.

 �To print

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <1>, <0>, <0> (function 
numbers), and then press the <OK> 
button.

3 Confirm that [Execute] is selected, and 
then press the <OK> button.

 �Printing result samples
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Printing Configuration Information

Printing Printer 
Information Lists

Demo Page

Prints demonstration pages.

 �To print

1 Press the scroll button  or .

2 Select [Print Information], and then 
press the <OK> button.

3 Select [Demo Page], and then press the 
<OK> button.

4 When [DEMO1] appears, select one of 
the items to be printed, and then press 
the <OK> button.

5 Confirm that [Execute] is selected, and 
then press the <OK> button.
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Printing Configuration Information

Error Log

Prints the history of the errors that have 
occurred in the device.

 �To print

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press <1>, <0>, <3> (function 
numbers), and then press the <OK> 
button.

3 Confirm that [Execute] is selected, and 
then press the <OK> button.

Usage Report

Prints the total print results.

Memo

 z Not displayed if [Usage Report] of [Print Statistics] is set 
to [Disable].

 �To print

1 Press the <Fn> key.

The numerical values input screen will 
be displayed.

2 Press<1>, <0>, <2> (function 
numbers), and then press the <OK> 
button.

3 Confirm that [Execute] is selected, and 
then press the <OK> button.
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Printing Configuration Information

4 Use the numeric keypad or the scroll 
buttons ( , ) to specify the number 
of copies, and then press the <OK> 
button.

Printing Print Lists

Color Profile List

Prints the table of the ICC profiles registered on 
the printer.

 �To print

1 Press the scroll button  or .

2 Select [Print Information], and then 
press the <OK> button.

3 Select [Color Profile List], and then 
press the <OK> button.

4 Confirm that [Execute] is selected, and 
then press the <OK> button.
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Printing Configuration Information

User Media List

Prints the table of the user media registered to 
the device.

Memo

 z Displayed when the user media is registered.

 �To print

1 Press the scroll button  or .

2 Select [Print Information], and then 
press the <OK> button.

3 Select [User Media List], and then press 
the <OK> button.

4 Confirm that [Execute] is selected, and 
then press the <OK> button.

Test Print

Prints the print quality lists.

 z Test Print-1

Prints the patterns for analyzing the print quality.

 z Test Print-2

Prints the patterns for analyzing CMYK print 
quality.

 z Test Print-3

Prints the patterns for analyzing  the status of 
the print cartridges. 

 z Test Print-4

Prints the patterns for analyzing print quality of 
the spot colors (white). Displayed with Pro1050 
only.

 �To print

1 Press the scroll button  or .

2 Select [Print Information], and then 
press the <OK> button.

3 Select [Test Print-1], [Test Print-2], 
[Test Print-3], or [Test Print-4], and 
then press the <OK> button.
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Printing Configuration Information

4 When [Execute] appears, press the 
<OK> button.

Changing the 
Administrator Password

Change the administrator password. The factory 
default setting is [999999].

1 Press the scroll button  or .

2 Select [Admin Setup], and then press 
the <OK> button.

3 Enter the administrator password, and 
then press the <OK> button.

4 Select [Change Password], and then 
press the <OK> button.
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Printing Configuration Information

5 Enter the new password, and then press 
the <OK> button.

Note

 z Specify a password that is at least six characters 
long.

6 Re-enter the new password, and then 
press the <OK> button.

7 Press the <ON LINE> button to return 
to the standby screen.
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Checking the Print Count

 Checking the Print Count
You can check the quantity of paper printed from the unwinder to date.

1 Press the scroll button  or .

2 Select [Configuration], and then press 
the <OK> button.

3 Select [Feeder Count], and then press 
the <OK> button.

4 Select the feeder you want to check.

5 Press the <OK> button.

6 Press the <ON LINE> button to return 
to the standby screen.
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8 
Utility Software Usable 

with This Printer
Utility List ………………………………… 140

Installing a Utility ……………………… 141

Color Correct Utility …………………… 143

Using a Web Browser to  
Configure the Network Setup ……… 153

Configuration Tool ……………………… 184

OKI LPR Utility…………………………… 190

Network Extension …………………… 195

Color Swatch Utility …………………… 197

Status Monitor …………………………… 199



- 140 -

Utility List

 Utility List

Utility Name Description Operating Environment Reference 
pages

Color Correct Utility Adjusts color matching.  
Can be used to change the overall 
tendency of output colors by adjusting 
the palette color output colors, and/
or by adjusting gamma values, and 
primary color hue and saturation.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/ 
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008

Page 143

Web Browser Can be used to view messages 
displayed on the printer, and to 
configure network settings and other 
settings.

Computer with Microsoft 
Internet Explorer, Safari, 
Google Chrome, or Firefox 
installed

Page 153

Configuration Tool Can be used to register and manage 
printer network settings with the 
printer's hard disk.
Can also be used to register and delete 
form data, and to manage saved jobs.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/ 
Windows Server 2012 R2/ 
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008

Page 184

Color Swatch Utility Prints color samples. This utility can 
be used to check printed colors. This 
utility is installed automatically when a 
printer driver is installed.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/ 
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008

Page 197

OKI LPR Utility Can be used to print over a network 
connection, to manage print jobs, and 
to check the printer status.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/ 
Windows Server 2012/ 
Windows Server 2008 R2/ 
Windows Server 2008/ 
Computer running TCP/IP

Page 190

Network Extension Can be used to check printer setup 
items from a printer driver and to 
configure option settings.  
This utility is installed automatically 
when a printer driver is installed on a 
network connection.

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/ 
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008/
Computer running TCP/IP

Page 195

Status Monitor Monitors the printer status.
Also can be used to acquire 
information of the reports below as a 
CSV file.
• Configuration
• Error Log
• Color Profile List
• User Media List

Windows 10/Windows 8.1/
Windows 8/Windows 7/
Windows Server 2016/
Windows Server 2012 R2/
Windows Server 2012/
Windows Server 2008 R2/
Windows Server 2008

Page 199
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Installing a Utility

 Installing a Utility
Use the procedure below to install the utility you 
want to use.

1 Insert the "Software DVD-ROM" into the 
computer.

2 On the "AutoPlay" screen that appears, 
click [Run Setup.exe].

3 When the "User Account Control" 
window is displayed, click [Yes].

4 Read the "Software License Agreement", 
and click [Accept].

5 Select the printer connection method, 
and then click [Next]. (In this example, 
we will select network connection.)

6 Start searching for a printer. After 
supported printers are detected, select 
this printer from the list and then click 
the [Next] button.

7 Click [Custom Install].

8 Select the check box next to the 
software you want to install, and then 
click [Install].

9 Confirm that the correct software is 
selected, and then click [Start].
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Installing a Utility

10 After installation is complete, click 
[Complete].

11 On the configuration screen of the 
device, click [Next].

12 On the completion screen, click [Exit] 
to exit installation.
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Color Correct Utility

 Color Correct Utility

Changing Palette Colors
The Color Correct  Utility can be used to 
specify palette colors selected with Microsoft 
Excel, Word, and other applications within the 
adjustment range.

Note

 z For information about the Color Correct Utility setup, see 
"Installing a Utility" (P.141).

 z To print using the sample print function or the test print 
function of the Color Correct Utility, load 130-mm wide 
Continuous Paper in the printer’s unwinder.

 z Configure settings for each of the printer drivers.

 z For test printing, use paper that is a size supported by the 
printer being used.

 z This utility cannot be used for a printer that is connected 
for printer sharing.

 z PC administrator privileges are required to use the Color 
Correct Utility for color matching.

1 Use the Color Correct Utility to perform 
color adjustment.

(1) Perform the following operation to 
start up the Color Correct Utility: 
[Start] > [Okidata] > [Color 
Correct Utility].

(2) Select [Office Palette Tuning], and 
then click [Next].

(3) On the "Select Printer" screen that 
appears, select the printer to be 
used, and then click [Next].

Memo

 z This displays a list of installed printer drivers. 
Configure settings for each of the printer drivers.

(4) On the "Select setting" screen that 
appears, select a setup, and then 
click [Print Sample].

This prints "Color Sample".

(Color Sample)
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Color Correct Utility

(5) Click [Next].

This displays the "Office Palette 
Tuning" screen.

(6) Click [Print Palette].

This prints "PALETTE COLOR SAMPLE".

(PALETTE COLOR SAMPLE)

Note

 z Items that are X'ed out (×) cannot be adjusted.

(7) Compare the palette (screen 
colors) of the "Office Palette 
Tuning" screen with the printed 
"PALETTE COLOR SAMPLE". If the 
colors are different, adjust them. 
(This example below shows palette 
color adjustment of the color 
circled in red, below.)

 z PALETTE COLOR SAMPLE

 z Office Palette Tuning Screen

(8) On the "Office Palette Tuning" 
screen, click the color to be 
adjusted (screen color).

This displays the "Adjustment values 
input" screen.
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Color Correct Utility

(9) Use the X-value and Y-value 
pulldown menus to check their 
allowable setting ranges, and then 
click [CANCEL].

Memo

 z In order to preserve overall balance, the 
allowable adjustment ranges depend on the 
color.

(10) For the adjustment color (screen 
color) of the "Office Palette 
Tuning” screen, search the "COLOR 
SELECTION SAMPLE" for the 
desired color within the adjustment 
range, and note the X-direction 
(hue) and Y-direction (brightness) 
values (X-value and Y-value).

(11) On the "Office Palette Tuning" 
screen, click the color to be 
adjusted (screen color).

This displays the "Adjustment values 
input" screen.

(12) On the "Adjustment values input" 
screen, select the X-value and 
Y-value you found in step (10) of 
this procedure, and then click [OK].

The display will return to the "Office 
Palette Tuning" screen.

(13) Click [Print Palette] to print the 
"PALETTE COLOR SAMPLE". After 
confirming that the changed 
"PALETTE COLOR SAMPLE" color 
is closer to the color sample color 
for the configured settings, click 
[Next].
For other colors you want to adjust, 
repeat steps (8) through (13) of this 
procedure.

(14) Enter the setting name, and then 
click [Save].
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Color Correct Utility

(15) Click [OK].

Note

 z If you update or re-install the printer driver, 
created color adjustment names will be 
re-imported when you start up the Color 
Correct Utility. After confirming that the Color 
Adjustment name is shown for [Select Setup], 
click [Exit].

(16) Click [Finish] to exit the Color 
Correct Utility.

2 Use a printer driver to select a setup 
name, and then print.

 �Windows PCL Printer Driver

(1) Open the file to be printed.

(2) Select [Print] in the [File] menu.

(3) Click [Preferences] (or 
[Properties]).

(4) On the [Color] tab, click 
[Detail], and then select [Simple 
Adjustment].

(5) Select the [Color Correct  Utility 
Settings] check box, select the 
settings you created with the Color 
Correct Utility, and then click [OK].

(6) Print.

Changing the Gamma 
Value and Hue

You can use the Color Correct Utility to adjust 
the gamma value and/or hue for color matching.

Note

 z For information about the Color Correct Utility setup, see 
"Installing a Utility" (P.141).

 z To print using the test print function of the Color Correct 
Utility, load 130-mm wide Continuous Paper in the device’s 
unwinder.

 z Configure settings for each of the printer drivers.

 z For test printing, use paper that is a size supported by the 
printer being used.

 z This utility cannot be used for a printer that is connected 
for printer sharing.

 z PC administrator privileges are required to use the Color 
Correct Utility.

1 Use the Color Correct Utility to change 
the gamma value, hue, and other 
settings.

(1) Perform the following operation to 
start up the Color Correct Utility: 
[Start] > [Okidata] > [Color 
Correct Utility].

(2) Select [Hue & Saturation Tuning], 
and then click [Next].
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Color Correct Utility

(3) On the "Select printer" screen that 
appears, select the printer to be 
adjusted, and then click [Next].

Memo

 z This displays a list of installed printer drivers. 
Configure settings for each of the printer drivers.

(4) On the "Select setting" screen that 
appears, select the mode you want 
to use as the standard, and then 
click [Next].

(5) To adjust, move the [Gamma], 
[Hue], and [Saturation] sliders.

Memo

 z The [Gamma] slider can be used to adjust 
overall brightness, while the [Brightness/
Saturation] slider adjusts the output color.

 z Brightness is increased by sliding the [Gamma] 
slider to the left.

 z You can change the color being adjusted by 
using the printer color buttons.

 z The [Hue] slider adjusts each color in the color 
wheel forward (+) direction or reverse (-) 
direction. For example, moving the slider in the 
plus (+) direction while Y (Yellow) is selected 
will move towards G (Green), while moving in 
the minus (-) direction moves towards R (Red).

C(Cyan) R(Red)

    Y
(Yellow)G(Green)

B(Blue) M(Magenta)

(+)

(-)

 z The [Use printer’s unadjusted color.] option 
adjusts based on use of colors that are 100% 
toner primary colors. Selecting the check box 
for this option fixes the [Gamma] slider for 
the selected color and performs adjustment so 
printing uses the toner blends shown below.

Printer 
Color Result

Cyan (C) Cyan toner 100%
Magenta (M) Magenta toner 100%
Yellow (Y) Yellow toner 100%
Red (R) Magenta toner 100% + Yellow toner 

100%
Green (G) Cyan toner 100% + Yellow toner 100%
Blue (B) Cyan toner 100% + Magenta toner 

100%



- 148 -

Color Correct Utility

(6) Click [Print Test].

This prints the "TEST PRINTING 
SAMPLE".

(7) Check the color adjustment result.
If adjustment results are not what you 
expected, repeat steps (5) and (6) of 
this procedure.

(8) Click [Next].

(9) Enter the setting name, and then 
click [Save].

(10) Click [OK].

Note

 z If you update or re-install the printer driver, 
created color adjustment names will be 
re-imported when you start up the Color 
Correct Utility. After confirming that the Color 
Adjustment name is shown for [Select Setup], 
click [Finish].

(11) Click [Finish] to exit the Color 
Correct Utility.

2 Use a printer driver to select a setup 
name, and then print.

 �Windows PCL Printer Driver

(1) Open the file to be printed.

(2) Select [Print] in the [File] menu.

(3) Click [Preferences] (or 
[Properties]).

(4) On the [Color] tab, click 
[Detail], and then select [Simple 
Adjustment].

(5) Select the [Color Correct Utility 
Settings] check box, select the 
settings you created with the Color 
Correct Utility, and then click [OK].

(6) Print.
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Saving a Color Adjustment 
Setup

You can use the Color Correct Utility to save a 
setup to a file.

Note

 z For information about the Color Correct Utility setup, see 
"Installing a Utility" (P.141).

 z Configure settings for each of the printer drivers.

 z This utility cannot be used for a printer that is connected 
for printer sharing.

 z PC administrator privileges are required to use the Color 
Correct Utility.

1 Start up the Color Correct Utility.

(1) Perform the following operation to 
start up the Color Correct Utility: 
[Start] > [Okidata] > [Color 
Correct Utility].

(2) Select [Import/Export Color 
Settings], and then click [Next].

(3) Select the printer whose setup you 
want to save, and then click [Next].

This displays the "Import/Export Color 
Settings" screen.
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2 Save the setup.

(1) Click [Export].

(2) On the "Export Settings" screen, 
select the settings you want to 
export, and then click [Export].

Memo

 z You can select multiple setups by holding down 
your computer's Ctrl or Shift key as you select.

(3) Select the save location, enter 
the name of folder for storing the 
setup, and then click [Save].

(4) Click [OK].

(5) Click [Finish] to exit the Color 
Correct Utility.

Importing a Color 
Adjustment Setup

You can use the procedure below to import a 
color adjustment setup from a file.

Note

 z For information about the Color Correct Utility setup, see 
"Installing a Utility" (P.141).

 z Configure settings for each of the printer drivers.

 z This utility cannot be used for a printer that is connected 
for printer sharing.

 z PC administrator privileges are required to use the Color 
Correct Utility.

1 Start up the Color Correct Utility.

(1) Perform the following operation to 
start up the Color Correct Utility: 
[Start] > [Okidata] > [Color 
Correct Utility].

(2) Select [Import/Export Color 
Settings], and then click [Next].
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(3) Select the printer whose setup 
you want to import, and then click 
[Next].

This displays the "Import/Export Color 
Settings" screen.

2 Import the setup.

(1) Click [Import].

(2) In the folder where the setup you 
want to import is stored, select the 
appropriate CCM file, and then click 
[Open].

(3) On the "Import Settings" screen 
that appears, select the setup you 
want to import, and then click 
[Import].

Memo

 z You can select multiple setups by holding down 
your computer's Ctrl or Shift key as you select.

(4) After confirming that the setup has 
been imported, click [Finish].
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Deleting a Color 
Adjustment Setup

You can use the procedure below to delete color 
adjustment setups you no longer need.

1 Perform the following operation to start 
up the Color Correct Utility: [Start] > 
[Oki Data] > [Color Correct Utility].

2 Select [Import/Export Color Settings], 
and then click [Next].

3 Select the printer whose setup you 
want to delete, and then click [Next].

4 From the list, select the setup you want 
to delete, and then click [Delete].

5 Click [Yes] to delete the setup.

6 After confirming that the setup has 
been deleted, click [Finish].
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 Using a Web Browser to Configure the Network 
Setup

Operating Environment
Computer with Microsoft Internet Explorer, 
Safari, Google Chrome, or Firefox installed

Computer running TCP/IP

Memo

 z Check to make sure that the security setting of the web 
browser is MEDIUM.

The explanation here is based on the example 
environment described below.

 z Printer name:  Pro1050

 z Printer IP address: 192.168.0.2

 z MAC Address:  00:80:87:84:9C:9B

 z Web Browser:  Microsoft Internet Explorer  
   Ver.11

Starting Up

1 Start up the web browser.

2 In the address bar, enter the following 
URL then press [Enter]: http://<printer 
IP address>/.

This displays the printer status screen.

Note

 z If the IP address includes a one-digit or two-digit 
number, do not enter leading zeros. Doing so may cause 
communication problems.  
Example:  Correct: http://192.168.0.2/ 

Incorrect: http://192.168.000.002/
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Logging in as an 
Administrator

Note

 z To change printer settings using a web browser, you need 
to log in as a printer administrator.

1 Click [Administrator Login].

2 For [Username] enter "root", for 
[Password] enter the current password, 
and then click [OK].

Memo

 z The password is the same as the control panel 
"Administrator Password".

3 Specify the configuration information 
that can be checked on the network, 
and then click [OK] or [SKIP].

Note

 z You can skip configuring settings by clicking [SKIP].

 z Selecting the [Do not show this page again] 
checkbox, and then clicking [OK] or [SKIP] will 
cause this page not to be displayed any more.

4 This will display the screen below.
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Item List
◎ : Appears for a person logged in as a printer 
administrator.

 �View Information

Item Description
Status Shows the current printer status. All warnings 

and errors generated by the printer are shown 
as "problem information". You can also check 
the operational status of each network service, 
a configuration list, and the IP address assigned 
to the printer. For information about the status 
window, see "To check using the "Status Screen"" 
(P.157).

Tray Count Shows the print count.

Supplies Life Shows the remaining life of consumables.

Usage Report Shows usage reports.

Network Can be used to check general information, TCP/
IP status, maintenance information, and other 
network-related setup information.

System Shows versions, memory capacity, flash memory 
capacity, and system related information.

 �Print Information　◎

Item Description
Information 
Print

Can be used to configure print and check 
information about the network, the font list, and 
other printer settings.

 �Printer Menu　◎

Item Description
General 
Printer 
Settings

Can be used to configure the printer name, asset 
number, installation location, and other printer 
settings.

Unwinder 
Config

You can do settings related to the unwinder and 
the paper loaded in the unwinder.

Cutter Setup You can set the cutter operations and the cutting 
interval. Appears when the unwinder is mounted.

System 
Adjust

Can be used to configure the power save time, and 
for clearing warnings, timeout printing, and other 
printer operations.

Print Adjust Can be used to configure print position adjustment, 
print quality, and to adjust other settings.

Unit of 
Measurement

You can set the units that are displayed.

 �Admin Setup　◎

Item Description
Network 
Setup

Can be used to configure TCP/IP and other protocol 
settings.

Print Setup Can be used to configure toner saving and other 
printer settings.

PCL Setup Can be used to configure PCL font and other PCL 
settings.

Color Setup Can be used to configure PostScript settings for 
the CMYK data conversion process and other color 
settings.

Management Can be used to configure the power setup, job 
cancel setup, and other printer settings.
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 �Calibration　◎

Item Description
Normal 
Setting

Adjusts the density of each color and other print 
quality settings.

Customize 
Menu

Used to perform density and registration 
adjustment.

 � Links

Item Description
Links Displays links configured by the administrator and 

links configured by the manufacturer.

Edit Links Allows administrator to set any URL. Up to five 
support links and five other links can be registered. 
Be sure to include http:// when entering the URL.

Changing an Administrator 
Password

You can use the procedure below to change 
the password for logging in to the printer as an 
administrator.

1 Click [Admin Setup] > [Management].

2 Click [Change Password].

3 In [New Password], enter the new 
password. In [Verify Password], enter 
the new password again.

Note

 z The password will appear on the screen as a series 
of dots (●●●●● ) as you enter it.

 z You can enter from 6 to 12 alphanumeric English 
characters for a password.

 z Note that passwords are case-sensitive, so enter 
upper-case and lower-case letters correctly.

4 Click [Submit].
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5 This saves the settings on the printer.

You do not need to re-start the printer. Use 
the new password the next time you log in 
as an administrator.

Checking Printer Settings 
From a Computer

You can use the procedures below to check the 
printer status from a computer over a network.

 �To check using the "Status Screen"

1 Access the printer web page and open 
the "Status" screen.

 �To check using the "Status 
Window"

Click [Status Window], which will display the 
screen shown below.

This 
displays 
details 
about the 
printer 
status.

Click 
to up-
date the 
printer 
status 
with the 
latest 
informa-
tion.

Shows 
printer 
informa-
tion.

Printer Status Icon Meaning
No error, online

Minor malfunction 
(printing still possible)
Serious malfunction 
(printing not possible)

Offline
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Changing Printer Settings 
From a Computer

You can use the procedure below to change 
printer settings.

1 Access the printer web page and log in 
as an administrator.

2 After changing the settings you want, 
click [Submit].

Encrypting Communication 
(SSL/TLS)

Communication between the computer (client) 
and printer can be encrypted when configuring 
settings, performing IPP printing, and when 
receiving print data with FTP protocol.

(Encryption of SSL/TLS Communication)

 �Configuring Settings
The procedure below shows how to use the web 
to create a certificate with the printer.

The two types of certificates below can be 
created.

 z Self-signed certificate

 z CA certificate (CSR creation)

Memo

 z If the printer's IP address is changed from what it was 
when a certificate was created, that certificate become 
invalid. Do not change the printer's IP address after 
creating a certificate.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click in the following sequence: [Admin 
Setup] > [Network Setup] > [Security].

3 Click [SSL/TLS].
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4 Select the type of the certificate to 
create in [Step 1].

5 Enter information for the Common 
Name, Organization, and other items.

Note

 z If you selected "Use a certificate issued by a 
certificate authority", perform detailed content 
input and other certificate issuing procedures in 
accordance with issuing authority procedures.

Memo

 z If you selected a self-signed certificate, the printer's 
IP address will be set for [Common Name].

If you want to change the key exchange 
method and key size, click [Key Exchange 
method]. (The initial default setting is RSA, 
1024 bits. Normally, you should use this 
setting without modifying it.) 

6 Click [Submit].

 �Self-signed Certificate
To create a CA certificate, advance to "CA 
Certificate" (P.160).

7 This displays the input.

Check the contents, and then click [OK]. 
This creates the certificate.

This completes self-signed certificate 
creation.

Settings are saved on the printer and the 
network function is restarted.

8 Perform steps 1 through 3 of this 
procedure to display the encryption 
(SSL/TLS) setup screen, and then 
configure protocol settings to enable 
encryption.

9 Click [Submit].

In this case, advance to "Usage Method" 
(P.160).
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 �CA Certificate

7 This displays the input.

Check the contents, and then click [OK].

8 Extract the CSR and send it to the 
issuing authority. (For a CA certificate)

Note

 z Copy the contents of the text box from "----- 
BEGIN CERTIFICATE REQUEST -----" to "----- END 
CERTIFICATE REQUEST -----". Depending on the 
CA, sending the CSR may mean pasting it into web 
page, sending it as a file, attaching it to a mail 
message, etc.

9 This installs the certificate issued by 
the CA (using the web). (For a CA 
certificate)

Perform steps 1 through 3 of this procedure 
to display the encryption (SSL/TLS) setup 
screen.

Paste the part of the generated certificate 
from "----- BEGIN CERTIFICATE -----" to "--
--- END CERTIFICATE -----" into the text 
box, and then click [Send].

This completes CA certificate creation.

Settings are saved on the printer and the 
network function is restarted.

10 Perform steps 1 through 3 of this 
procedure to display the encryption 
(SSL/TLS) setup screen, and then 
configure protocol settings to enable 
encryption.

11 Click [Submit].

 �Usage Method

1 Start up the web browser, and then 
enter "https://<printer IP address>" as 
the address to connect.
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Printing with IPP
Printing can be performed using IPP.

 �To enable IPP printing

1 Access the printer web page and log in 
as an administrator.

2 Select [Admin Setup].

3 Select the following: [Network Setup] > 
[IPP] > [Setting].

4 Follow the instructions that appear on 
the display to configure the setup.

5 Click [Submit].

 �To set up the printer as an IPP 
printer (Windows)

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Select [View devices and printers] > 
[Add a printer].

3 From the list of usable printers, select 
[The printer that I want isn’t listed].

4 Select [Select a shared printer by 
name].

5 Enter "http://<printer IP address>/ipp" 
or "http://<printer IP address>/ipp/lp", 
and then click [Next].

6 Click [Have Disk].

7 Insert the "Software DVD-ROM" into the 
computer.

8 For [Copy manufacturer's files from], 
enter one of the paths below, and then 
click [Find].

 z PCL driver:  
 D:\Drivers\PCLXL

Memo

 z The above is an example when the DVD-ROM drive 
is the D: drive.

9 Select the INF file, and then click 
[Open].
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10 Click [OK].

11 Select the printer name, and then click 
[Next].

12 Click [Next].

13 Click [Finish].

14 A test page is printed after installation 
is complete.

Encrypting Communication 
(IPsec)

You can configure the settings in this section 
to encrypt and prevent tampering with 
communication between the computer (client) 
and printer at the network layer level.

Memo

 z The IKE protocol supported by this printer is "IKEv1".  
The communication mode supported by this printer is 
"Transport Mode". It does not support "Tunnel Mode".  
Printer response may slow down while IPsec is enabled, 
depending on network communication conditions.

Note

 z IPsec does not operate with the mail send function or 
SNMP Trap function.

 �Setup Flow
Configure printer settings before configuring 
computer settings.

 �To configure the printer setup
The procedure below shows how to use the web 
to enable IPsec.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click in the following sequence: [Admin 
Setup] > [Network Setup] > [Security].

3 Click the [IPsec] tab.
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4 Under [STEP1], enable [IPsec].

Note

 z Set "Enable" for IPsec to encrypt communications 
from the computer with the IP address you specified 
in "STEP2".

 z The web page will not open if IPsec setup fails 
because the configured parameters to not match the 
computer, or because of some other reason. If this 
happens, use the control panel Network Setup item 
to disable [IPsec], or perform network initialization 
to disable IPsec.

5 Under [STEP2], enter the host IP 
address.

Note

 z Use an IP address to specify a host that is allowed 
to print and configure settings.

 z For the IPv4 address, use single-byte numerals 
separated by periods (.).

 z For the IPv6 address, use single-byte alphanumeric 
characters separated by colons (:). Abbreviated 
notation is not supported.

 z Entry of IP address 0.0.0.0. is invalid.

6 Under [STEP3], configure the settings 
of the Phase1 Proposal parameters.

(1) For [IKE Encryption Algorithm], 
select one of the following settings: 
AES-CBC 256, AES-CBC 192, AES-
CBC 128, 3DES-CBC, DES-CBC.

(2) For [IKE Hash Algorithm], select 
SHA-1 or MD5.

(3) For [Diffie-Hellman Group], select 
Group2 or Group1.

(4) For [Lifetime], enter and set a 
value in the range of 600 (seconds) 
to 86,400 (seconds).

7 Under [STEP4], set the pre-shared key.

For [Pre-Shared Key], enter at least one and 
no more than 64 single-byte alphanumeric 
characters. Here, we will show an example 
where "ipsec" is entered for the character 
string.
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8 Under [STEP5], set the Key PFS.

(1) For [Key PFS], select KEYPFS or 
NOPFS.

(2) If [Key PFS] is selected, select one 
of the following settings for [Key 
PFS Diffie-Hellman Group]: Group 
2, Group 1, None.

9 Under [STEP6], configure Phase2 
Proposal settings.

 z To configure [ESP] settings

(1) For [ESP Encryption Algorithm], 
select one of the following settings: 
AES-CBC 256, AES-CBC 192, AES-
CBC 128, 3DES-CBC, DES-CBC.

(2) For [ESP Authentication Algorithm], 
select SHA-1, MD5, or OFF. If you 
select [OFF], the ESP verification 
algorithm will not be applied.

 z To configure [AH] settings

(1) For [AH Authentication Algorithm], 
select SHA-1 or MD5.

(2) For [LifeTime], enter and set a 
value in the range of 600 (seconds) 
to 86,400 (seconds).

10 Click [Submit].
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11 Settings are saved on the printer and 
the network function is restarted.

 �To configure computer settings

1 Click [Start], and then select [Control 
panel] in [Windows System].

2 Click [System and Security].

3 Click [Administrative Tools].

 �Connection Security Rules

4 Double-click [Local Security Policy].
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5 Select [Windows Firewall with Advanced 
Security] > [Windows Firewall with 
Advanced Security - Local Group Policy 
Object], right-click [Connection Security 
Rules], and then select [New Rule].

6 Select [Custom], and then click [Next].

7 Select Endpoint 1 and 2. Configure as 
required, and then click [Next].

8 Select [Require authentication for 
inbound connections and request 
authentication for outbound 
connections], and then click [Next].

9 Select [Advanced], and then click 
[Customize].

10 In the [First authentication] section, 
click [Add].

11 Select [Preshared Key] and enter the 
key, and then click [OK].
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12 Click [OK].

13 Click [Next].

14 Click [Next].

15 After confirming that all of the check 
boxes are selected, click [Next].

16 Enter a name, and then click [Finish].

 � IPsec Setup

17 Open the [Local Security Policy] of the 
[Administrative Tools].

18 Right-click [Windows Firewall with 
Advanced Security], and then select 
[Properties].

19 Select the [IPsec Settings] tab. Next, 
in the [IPsec defaults] section, click 
[Customize].
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20 In the [Key exchange (Main Mode)] 
section, select [Advanced], and then 
click [Customize].

21 Change the [Security Methods] as 
required, and then click [OK].

22 In the [Data protection (Quick Mode)] 
section, select [Advanced], and then 
click [Customize].

23 Configure the settings you want, and 
then click [OK].

Note

 z Support is provided only for time indicated by the 
key lifetime. To disable session-specific (IPsec 
communication data size) conditions, set the 
maximum value.

 z Select "ESP+AH" as the protocol.

24 In the [Authentication method] section, 
select [Advanced], and then click 
[Customize].

25 In the [First authentication] section, 
click [Add].
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26 Select [Preshared Key] and enter the 
key, and then click [OK].

27 Click [OK].

28 Click [OK] to exit [Customize IPsec 
Settings].

29 Click [OK].

Controlling Access by IP 
Address (IP Filter)

Access to the printer can be managed using IP 
addresses.

Note

 z [IP Filtering] is set to [Disable] under the printer initial 
default settings.

 z Take care to enter the IP address correctly. An incorrectly 
entered IP address can make it impossible to access the 
printer using IP protocol.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click in the following sequence: [Admin 
Setup] > [Network Setup] > [Security].

3 Click [IP Filtering].
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4 Under [STEP1], select [Enable] for [IP 
Filtering].

Note

 z Enabling IP filtering disables all access from hosts 
that are outside the range of IP addresses specified 
in [STEP2].

5 Under [STEP2], specify the IP address 
range.

Note

 z Using IP addresses, enter the range of hosts that 
are allowed to print and configure settings.

 z For the IP addresses, use single-byte numerals 
separated by periods (.).

 z Entry of IP address 0.0.0.0. is invalid.

 z When there is overlap of IP addresses, the address 
range with the highest level set in [Priority] is given 
priority.

 z Regardless of what is specified in [STEP2], you can 
use [STEP3] to specify administrator addresses 
for which printing and setting configuration are 
enabled.

6 Click [Address Range Bar Display/
Refresh].

If you want to modify an IP address range, 
re-enter the applicable IP addresses, and 
click [Address Range Bar Display/Refresh] 
again.

7 Under [STEP3], specify the 
[Administrator’s IP Address setting].

Even if the wrong settings are configured 
in [STEP2] due to administrator IP address 
entry in [Administrator’s IP Address 
setting], the administrator can re-configure 
the setting from a host with the IP address 
specified with [Administrator’s IP Address 
setting].

Note

 z If the printer is being accessed via a proxy, the 
intermediate device's address will be displayed 
as [Your Current Local Host/Proxy IP Address]. 
Consequently, the address shown by [Your Host IP 
Address] may be different from your actual host 
address.

 z If nothing is registered for the administrator IP 
address, the setting in [STEP2] may make the 
printer completely inaccessible.

 z If you do not want to register an administrator IP 
address, leave [Administrator’s IP Address setting] 
blank.

8 Click [Submit].

9 Settings are saved on the printer and 
the network function is restarted.
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Controlling Access by MAC 
Address

Access to the printer can be managed using MAC 
addresses.

Note

 z Incorrectly entering a MAC address can make it impossible 
to access the printer using a network. Exercise caution 
when entering an address.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click in the following sequence: [Admin 
Setup] > [Network Setup] > [Security].

3 Click [MAC Address Filtering].

4 Under [STEP1], select [Enable] for [MAC 
Address Filtering].

5 Under [STEP2], You can select [Accept] 
or [Deny] for communication from 
specific MAC addresses.

Note

 z Using MAC addresses, enter the range of hosts 
whose communications are allowed or rejected.

 z For the MAC addresses, use single-byte numerals 
separated by periods (:).

 z Regardless of what is specified in [STEP2], you can 
use [STEP3] to specify administrator addresses for 
which communication is enabled.
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6 Under [STEP3], specify the 
[Administrator’s MAC Address setting].

Even if the wrong settings are configured in 
[STEP2] due to administrator MAC address 
entry in [Administrator’s MAC Address 
setting], the administrator can re-configure 
the setting from a host with the MAC 
address specified with [Administrator’s MAC 
Address setting].

Note

 z If the printer is being accessed via a proxy, the 
intermediate device's address will be displayed 
as [Your Host MAC Address]. Consequently, the 
address shown by [Your Host MAC Address] may be 
different from your actual host address.

 z If nothing is registered for the administrator MAC 
address, the setting in [STEP2] may make the 
printer completely inaccessible.

 z If you do not want to register an administrator 
MAC address, specify 00:00:00:00:00:00 for 
[Administrator’s MAC Address setting].

7 Click [Submit].

8 Settings are saved on the printer and 
the network function is restarted.

Sending Error Notifications 
by Mail

The printer comes with a mail sending function 
(SMTP) built-in. It can be configured to send a 
mail message whenever an error occurs. You can 
select whether to send a periodic mail message 
about errors, or to send a mail message as soon 
as an error occurs.

 �To configure settings for sending 
mail

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click: [Admin Setup] > [Network 
Setup].

 

3 Click: [Email] > [Send Settings].
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4 Under [STEP1], select [Enable] for 
[SMTP Send].

5 Under [STEP2], specify the required 
addresses.

(1) For [SMTP Server], specify the mail 
server domain name or IP address.

(2) For [Printer Email Address], specify 
the mail address assigned to the 
printer.

Note

 z To configure SMTP server settings with a domain 
name, you need to configure DNS server settings 
with the [TCP/IP] setup.

 z The mail server needs to be configured to allow 
the printer to send mail. For information about 
mail server settings, consult with your network 
administrator.

 z Internet Explorer 7 configured with its initial default 
setup will not perform a send test.  
To perform a send test, you need to change the 
setup of Internet Explorer 7.  
Select [Tools] > [Security Level Customization], 
and then enable [Allow websites to prompt for 
information using scripted windows].

6 To configure more advanced settings 
from this point, click [Set detail of the 
SMTP Protocol.] for [STEP3].

Otherwise, jump to step 16 of this 
procedure.

7 Click [Security Settings].

8 For [SMTP Port Number], specify the 
mail server port number.

9 Select [Enable] for [SMTP-Auth].

(1) For [User ID], specify the user ID 
for connection to the mail server.

(2) For [Password], specify the 
password for connection to the 
mail server.

10 Click [OK].

11 Click [Configure attached information].
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12 Select or enter the information you 
want to add to the end of the message 
text.

13 Click [OK].

14 Click [Others].

15 For [Reply-To Address], specify the 
return address for the mail sent from 
the printer. Normally, specify the mail 
address of the printer administrator.

16 Click [OK].

17 Click [Submit].

18 Settings are saved on the printer and 
the network function is restarted.

Memo

 z The authentication method is automatically selected from 
among authentication methods supported by the mail 
server.

Sending Error Notifications 
by Periodic Mail

 �To send periodic notifications 
about problems

For periodic notification, check that Auto Power 
Off setting is either Auto Config or Disable.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 Click: [Admin Setup] > [Network 
Setup].

3 Click: [Email] > [Alert Settings].
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4 Enter the mail address of the 
malfunction notification recipient.

5 Click [Setting] of the mail address you 
want to specify.

Memo

 z Malfunction notification condition settings can be 
copied to another addressee by clicking [Copy]. This 
is useful when sending malfunction notifications to 
multiple recipients with similar mail addresses.

6 Select the [Periodically] check box, and 
then click [To STEP2].

7 For [Email Alert Interval], specify the 
mail send interval.

Memo

 z Mail is not sent if there are no reportable errors 
within the period.

8 Under [Setting Events Used for Sending 
Email Alerts], select the check boxes of 
the error types for you to be notified of.

9 Click [OK].

10 Check the configuration of the 
malfunction notification conditions.

 z To display as a list

(1) Click [Show current settings table].

(2) Check the configuration, and then 
close the window.
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 z To compare the setting conditions of two 
recipients

(1) Use the list box to select each 
of the recipients you want to 
compare.

(2) Check the displayed configuration.

Memo

 z You can change notification condition settings by 
clicking inside the setting condition comparison 
table.

11 Click [Submit].

12 Settings are saved on the printer and 
the network function is restarted.

 �To send alerts when problems 
occur

1 Click: [Email] > [Alert Settings].

2 Enter the mail address of the 
malfunction notification recipient.

3 Click [Setting] of the mail address you 
want to specify.

Memo

 z Malfunction notification condition settings can be 
copied to another addressee by clicking [Copy]. This 
is useful when sending malfunction notifications to 
multiple recipients with similar mail addresses.

4 Select the [Upon occurrence of an 
event] check box, and then click [To 
STEP2].
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5 Under [Setting Events Used for Sending 
Email Alerts], select the check boxes of 
the error types for you to be notified of.

6 Specify the delay after an error occurs 
until the message is sent, and then click 
[OK].

Memo

 z Setting a delay time makes it possible to send 
notifications only of errors that are generated only 
over a long period of time.

 z Setting "0 hours, 0 minutes" for the delay time, 
causes the message to be sent immediately after an 
error occurs.

7 Click [OK].

8 Check the configuration of the 
malfunction notification conditions.

 z To display as a list

(1) Click [Show current settings table].

(2) Check the configuration, and then 
close the window.

 z To compare the setting conditions of two 
recipients

(1) Use the list box to select each 
of the recipients you want to 
compare.

(2) Check the displayed configuration.

Memo

 z You can change notification condition settings by 
clicking inside the setting condition comparison 
table.

9 Click [Submit].

10 Settings are saved on the printer and 
the network function is restarted.
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Using SNMPv3
This printer implements an SNMPv3 compatible 
agent.

You can use an SNMPv3 compatible SNMP 
manager to encrypt printer administration with 
SNMP for greater security.

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 On the [Admin Setup] tab, click 
[Network Setup].

3 Click [SNMP] > [Settings].

4 Select the check box of the SNMP 
version to be used in [STEP1], and then 
click [To STEP2].

Memo

 z If [SNMPv3] is selected, you will not be able to view 
or configure settings with SNMPv1. If [SNMPv3+v1] 
is selected, you will be able to view settings with 
either SNMPv1 or SNMPv3, but you can configure 
settings using SNMPv3 only.

5 In [STEP2], enter an SNMPv3 user 
name for [User Name].

6 Enter the passphrase for verification 
in [Passphrase] for [Authentication 
Settings].
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7 Select [Algorithm].

8 Enter the passphrase for encryption in 
[Passphrase] for [Privacy (Encription) 
Settings].

Memo

 z You can select [DES] only for the encryption 
algorithm.

9 Click [Submit].

10 Settings are saved on the printer and 
the network function is restarted.

Memo

 z For the context key of the SNMP manager to be used, 
specify "v3context".

Using IEEE802.1X
Authentication is in accordance with IEEE802.1X.

 � IEEE802.1X Setup Flow
To configure IEEE802.1X settings on the printer, 
first connect the printer and computer via a 
normal hub for setup. After completing the 
IEEE802.1X setting configuration procedure, 
connect the printer to the authentication switch.

1 Connect the printer to a computer.

2 On the computer, specify an IP address 
for setting up.

3 On the printer, specify an IP address for 
setting up.

4 On the printer, configure IEEE802.1 
settings.

5 Connect the printer to the 
authentication switch.
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 �To configure IEEE802.1 settings

1 Log in as an administrator.

Reference

 z See "Logging in as an Administrator" (P.154).

2 On the [Admin Setup] tab, click 
[Network Setup].

3 Click [IEEE802.1X].

Reference

 z If PEAP is to be used, proceed to "� To use PEAP". 
If EAP-TLS is to be used, proceed to "� To use EAP-
TLS".

 �To use PEAP

4 For the [IEEE802.1X] setting, select 
[Enable].

5 For [EAP Type], select [PEAP].

6 In [EAP User], enter the user name.

7 In [EAP Password], enter the password.

8 Select the [Authenticate Server] check 
box.
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9 Click [Import of CA Certificate].

Memo

 z If the [Not authenticate Server] check box is 
selected, import of a CA certificate is not required.  
If the [Not authenticate Server] check box is 
selected, there is no confirmation to determine if 
the connection is to a properly authenticated server.

This displays the "Import of CA Certificate" 
screen.

10 Enter the file name of the CA certificate, 
and then click [OK].

Memo

 z The imported CA certificate is a certificate of the 
server certificate issuing authority of the RADIUS 
server.

 z Supported import file formats are PEM, DER, and 
PKCS#7.

The CA certificate is imported by the printer.

11 Click [Submit].

12 Settings are saved on the printer and 
the network function is restarted.

When the standby screen appears on the 
control panel, turn off the printer.

Reference

 z For information about how to turn off the printer, 
refer to the "Setup Guide".

 z Advance to "To connect the printer to an 
authentication switch" (P.183).

 �To use EAP-TLS

4 For the [IEEE802.1X] setting, select 
[Enable].

5 For [EAP Type], select [EAP-TLS].

6 In [EAP User], enter the user name.

7 Select the [Not use SSL/TLS Certificate 
for EAP authentication] check box.

8 Click [Import of Client Certificate].

This displays the "Import of Client 
Certificate" screen.

9 Enter the file name of the client 
certificate.

Memo

 z The importable certificate file format is PKCS#12.
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10 Enter the client certificate password, 
and then click [OK].

The client certificate is imported by the 
printer.

11 Select the [Authenticate Server] check 
box.

12 Click [Import of CA Certificate].

Memo

 z If the [Not authenticate Server] check box is 
selected, import of a CA certificate is not required.  
If the [Not authenticate Server] check box is 
selected, there is no confirmation to determine 
if the connection is to the correct authenticated 
server.

This displays the "Import of CA Certificate" 
screen.

13 Enter the file name of the CA certificate, 
and then click [OK].

Memo

 z The imported CA certificate is a certificate of the 
server certificate issuing authority of the RADIUS 
server.

 z Supported import file formats are PEM, DER, and 
PKCS#7.

The CA certificate is imported by the printer.

14 Click [Submit].

15 Settings are saved on the printer and 
the network function is restarted.

When the standby screen appears on the 
control panel, turn off the printer.

Reference

 z For information about how to turn off the printer, 
refer to the "Setup Guide".

 z Advance to "To connect the printer to an 
authentication switch" (P.183).
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 �To connect the printer to an 
authentication switch

Memo

 z Confirm that the printer is turned off.

1 Plug a LAN cable into the printer's LAN 
(network) interface connector.

2 Plug the LAN cable into the 
authentication switch's authentication 
port.

3 Turn on the power supply of the printer.

4 Confirm that the standby screen is 
displayed on the control panel.

5 Configure settings in accordance with 
the operating environment, such as the 
printer's IP address, etc.
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 Configuration Tool
Configuration Tool is a utility for modifying and managing OKI device settings.

Configuration Tool has the functions below for simple configuration and management of multiple OKI 
devices.

 z Device information display

 z ICC profile registration and management

 z Form data registration and delete

 z Saved job management

 z Partition formatting

 z Hard disk partition re-sizing

 z Flash memory initialization

 z Printer network setting configuration

Operating Environment
Computer running the Japanese version of 
Windows 10/Windows 8.1/Windows 8/Windows 
7/Windows Server 2016/Windows Server 2012 
R2/Windows Server 2012/Windows Server 2008 
R2/Windows Server 2008

Note

 z PC administrator privileges are required for the setup.

Registering a Device
The first time you use Configuration Tool or the 
first time you newly introduce an OKI device, the 
OKI device will be registered to Configuration 
Tool.

1 Perform the following operation to 
start up Configuration Tool: [Start] > 
[Okidata] > [Configuration Tool].
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2 On the [Tools] menu, select [Register 
Device] to search for registerable OKI 
devices.

Memo

 z To modify the scope of the search, select 
[Environment Settings] on the [Tools] menu, and 
then enter the scope. After entering the scope, click 
[OK].

3 Select the check box next to the OKI 
devices you want to set up or manage, 
and then click [Register].

4 Click the close button ( ) in the upper 
right corner of the window or click 
[Cancel] to close the [Register Device] 
screen.

Device Info Tab
You can use this tab to view the status of and 
details about OKI devices.

This function is provided with Configuration Tool 
as standard.

1 In the "Registered Device Table", click 
the OKI device whose information you 
want to view.

This displays the status of the OKI device.

Memo

 z To update information, click [Update Device 
Information].

Note

 z The device status is displayed when the OKI device 
is connected to the network.
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Network Setting Plug-in
This plug-in makes it possible to configure 
network settings with Configuration Tool. Before 
configuring settings, install the Network Setting 
plug-in.

 � Icon Types
The meaning of each icon is described below.

Icon Description
Search for the printer again.

Change search criteria.

Change the printer IP address.

Re-start the printer.

Change the network password.

Display the specified printer web 
page.

 �To search for the printer on a 
network

You can use the procedure below to search for 
the printer.

1 On the [Plug-ins] menu, select [Network 
Setting].

2 Select [Discover Devices].

This will display the search results.

 �To specify search criteria

1 On the [Plug-ins] menu, select [Network 
Setting].

2 Select [Environment Settings].

3 Specify search criteria as required, and 
then click [OK].

 �To change the printer IP address
You can use the procedure below to change the 
printer IP address.

1 In the printer list, select a printer.

2 Click .

3 Modify settings as required.

4 Click [Setup].

5 Enter the network password, and then 
click [OK].

The initial factory default password is the 
last six numerical digits of the MAC address.

6 Click [OK] to restart the printer.
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Storage Manager Plug-in
The Storage Manager plug-in can be used to 
manage jobs stored on the printer, to save forms 
and fonts used for printing, and ICC profiles.

Note

 z The job management function does not support handling 
of encrypted secure jobs.

 � Icon Types
The meaning of each icon is described below.

Icon Description
Create a new project.

Open a project.

Save a project.

Name a project and save it.

Add a file to a project.

Delete a file from a project.

Display the PCL form file filtering 
screen.
Create a download file.

Send a download file.

Send a project.

Send a file.

Display the job management screen.

Display the management function 
screen.

 �Registering an ICC Profile
Printer profiles can be registered and edited as 
required. The information below explains some 
of the profile functions.

An ICC profile can be used only by a printer 
equipped with a hard disk.

Note

 z To use profile registration and editing, install the Storage 
Manager plug-in.

1 On the [Plug-ins] menu, select [Storage 
Manager].

2 Click [ ] to create a new project.

3 Click [ ]. On the [Open File] dialog 
box that appears, change [File Type] to 
"ICC Profile (*.ICC, *.ICM)".

4 Select the file you want to register, and 
then click [Open].

5 For the ICC profile added to the project, 
click [Component] to display the [Edit 
File] dialog box.

6 Select the number where you want to 
register the profile.

Numbers that are already being used for 
another project are highlighted in yellow, 
indicating that they cannot be selected.

7 Enter comment text into the 
[Comments] box, if you want.

8 Click [OK] to apply the changes.

9 At the bottom of the screen, select the 
printer on the device list.

10 Click [ ] to send the project associated 
with the added ICC profile to the 
printer.

11 If a "Finished" message appears, read 
it, and then click [OK].
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 �Registering a Form (Form Overlay)
You can register logos and other forms on the 
printer and overlay them for printing. Here, we 
will show how to register a form.

 �Creating a Form

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

Note

 z The printer driver has its own function for 
registering forms. 
Normally, use the form registration function on the 
printer driver.

 z Form registration when the length of 1 page of 
labels, or of paper, is shorter than 4 inches, is not 
supported by this procedure. 
Use the form registration function on the printer 
driver.

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printer Properties].

4 Select the [Ports] tab, select check 
[FILE:] in [Printer Port], and then click 
[OK].

5 Create the form you want to register on 
the printer.

6 On the application [File] menu, select 
[Print].

7 Print.

8 Enter a name for the file to be saved.

9 On the [Port] tab, return the [Printer 
port] setting, which you changed in 
step 3 of this procedure, to its original 
setting.

 �Using Configuration Tool to Register a 
Form on the Printer

1 On the [Plug-ins] menu, select [Storage 
Manager].

2 Click [ ].

3 Click [ ], and then select the created 
form file.

This adds the form to the project.

4 Click the form file.

5 Enter the [ID], and then click [OK].

Note

 z Do not change the [Volume] and [Path Name] 
settings.

6 In the bottom pane of the Storage 
Manager plug-in screen, select the 
printer.

7 Click [ ].

8 Click [OK].
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 �To check the hard disk and flash 
memory free space

You can use the procedure below to check hard 
disk and flash memory free space.

1 In the device selection area at the 
bottom of the Storage Manager plug-in 
screen, click the printer name to display 
the resource screen of the selected 
printer.

2 The screen shows storage, partitions, 
directories, files, and other information 
by communicating with the printer.

 �To delete unneeded jobs from the 
hard disk

You can use the procedure below to delete print 
jobs in a hard disk [Shared] partition.

Memo

 z Even after print data is secure printed or saved, its job 
remains in the [Common] partition. Jobs use up hard disk 
space and can cause it to run low if jobs are not deleted.

Note

 z The Storage Manager plug-in cannot delete encrypted 
secure print jobs.

1 Click [ ].

2 To view the print jobs of a particular 
user, enter the applicable password, and 
then click [Job password operations].  
To view all print jobs, enter an 
administrator password, and then click 
[Administrator password operations].

The initial default administrator password is 
999999.

3 Select the job you want to delete, and 
then click [ ].

4 Click [OK].



- 190 -

OKI LPR Utility

 OKI LPR Utility

Operating Environment
Computer running the Japanese version of 
Windows 10/Windows 8.1/Windows 8/Windows 
7/Windows Server 2016/Windows Server 2012 
R2/Windows Server 2012/Windows Server 2008 
R2/Windows Server 2008

Computer running TCP/IP

Note

 z PC administrator privileges are required for the setup.

 z Use of printing method function is not supported.

Starting Up

1 Perform the following operation to 
start up the OKI LPR Utility: [Start] > 
[Okidata] > [OKI LPR Utility].

This will display a screen like the one below.
Shows the number of 
jobs (data) that have 
been sent.

Shows the num-
ber of jobs (data) 
that have not yet 
been sent.

Shows the status of OKI LPR Utility 
printers. (May differ from the actual 
printer status.)

Displayed when 
"Show Comments" 
is selected with 
"Adding Comments" 
(P.193).

Printers registered 
with the OKI LPR 
Utility

Downloading a File to the 
Printer

You can use the procedure to download a file to 
the printer.

1 Select this printer.

2 On the [Remote Print] menu, select 
[Download].

3 Select the file to be downloaded, and 
then click [Open].

This starts file downloading.
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Viewing, Deleting, and 
Transferring Jobs

You can use the procedure below to display and 
delete jobs.

You can also transfer print jobs to another 
printer when printing is not possible on this 
printer because it busy, offline, out of paper, etc.

Note

 z A job cannot be transferred to another manufacturer's 
printer.

 z Transfer jobs to a printer that is the same model as the 
source printer.

1 Select this printer.

2 On the [Remote Print] menu, select [Job 
Status].

This displays the jobs.

3 Select the print job you want to delete. 
Next, on the [Job] menu, select [Delete 
Job].

This deletes the job.

4 Select the print job you want to transfer. 
Next, on the [Job] menu, select the 
printer to transfer to in [Redirect].

This transfers the job to the destination 
printer.

Note

 z The printer being transferred to must be set up 
beforehand using the OKI LPR Utility.

Checking the Printer 
Status

You can use the procedure below to display the 
status of the printer.

1 Select this printer.

2 On the [Remote Print] menu, select 
[Printer Status].

This displays the printer status screen.

Memo

 z You can also check the printer status using "Status" on the 
job display dialog box.
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Adding a Printer
You can use the procedure below to change the 
print destination port to an OKI LPR port.

Note

 z You cannot configure this setting for a printer that is 
already registered with the OKI LPR Utility. To change the 
port in this case, select [Reset Printer].

1 On the [Remote Print] menu, select [Add 
Printer].

2 Use [Printer Name] to select the 
name of the printer to be added, use 
[IP Address] to enter the printer's IP 
address, and then click [OK].

Note

 z [Printer Name] is displayed only if a printer driver has 
been added to the [Devices and Printers] folder. It does 
not appear when the printer is configured as a network 
printer.

Memo

 z You can search for OKI printers on the network by clicking 
[Discover].

The printer is added to the main window.

Starting Up the Web 
Browser

The OKI LPR Utility starts up the web browser 
for configuration of printer network settings and 
menu settings.

1 Select this printer.

2 On the [Remote Print] menu, select 
[Web Setting].

Memo

 z If the web port number has changed, use the 
procedure below to change the OKI LPR Utility port 
number setting.

(1) Select this printer.

(2) On the [Remote Print] menu, select 
[Confirm Connections].

(3) Click [Details].
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(4) For [Port Numbers], enter the web 
port number.

(5) Click [OK].

Adding Comments
You can use the procedure below to add 
comments to the printers added to the OKI LPR 
Utility.

Memo

 z This can be used to enter information about the printer 
location, optional devices, etc.

1 Select a printer.

2 On the [Remote Print] menu, select 
[Confirm Connections].

3 Enter the comment text into 
[Comment], and then click [OK].

4 On the [Option] menu, select [Show 
comments].
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Automatic IP Address 
Setting

You can have the server automatically search 
for and reset IP addresses that were changed 
when a printer’s power was turned on while it is 
connected to the DHCP server.

Note

 z The search is performed in accordance with the search 
scope of the OKI LPR Utility.

Memo

 z Enabled in the initial settings of the device.

1 On the [Option] menu, select [Setup].

2 Select the [Auto Reconnect] check box.

3 Click [OK].

Uninstalling the Utility

1 On the [File] menu, select [Exit].

2 Select [Start] > [Okidata] > [Uninstall 
OKI LPR Utility] to start the Uninstall 
OKI LPR Utility.

On the "User Account Control" dialog box 
that appears, click [Yes].

3 Click [Yes].

This starts the delete operation.
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 Network Extension
Network Extension makes it easy to check printer setup items from a printer driver.

Reference

 z Network Extension is installed along with the printer drivers.

Operating Environment
Computer running the Japanese version of 
Windows 10/Windows 8.1/Windows 8/Windows 
7/Windows Server 2016/Windows Server 2012 
R2/Windows 2012/Windows Server 2008 R2/
Windows Server 2008

Computer running TCP/IP

Note

 z To link operation with a printer driver, you need to install 
the printer driver.

 z Network Extension is installed automatically when a 
printer driver is installed on a TCP/IP network connection.

 z Operation is supported only for the printer driver 
connection destinations shown below.

 - OKI LPR Port

 - Standard TCP/IP port

 z PC administrator privileges are required for the setup.

Checking the Printer 
Settings

You can use the procedure below to check 
connected printer configuration, etc.

Note

 z Even if Network Extension is installed, the [Options] 
tab will not be displayed if the operating environment is 
incompatible.

1 Click [Start] and select [Control Panel] 
in [Windows System].

2 Click [View devices and printers].

3 Right-click the [Pro1050 PCL6] icon, 
and then select [Printer Properties].

4 Click the [Status] tab.
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5 Click [Update].

The printer configuration is displayed under 
"Device Setting".

6 Click [OK].

Memo

 z Clicking [Web Setting] automatically starts up the web 
browser, which will display the printer configuration. 
For details, see "Using a Web Browser to Configure the 
Network Setup" (P.153).

Uninstalling Network 
Extension

1 Click [Start], and then select [Control 
panel] in [Windows System].

2 Click [Uninstall a program].

3 Select [OKI Network Extension], and 
then click [Uninstall].

4 Follow the instructions on the screen to 
uninstall.
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 Color Swatch Utility

Operating Environment
The Color Swatch Utility prints RGB color 
samples for the printer. Printed color samples 
can be used to determine the RGB value settings 
that need to be specified with an application in 
order to obtain desired printed colors.

Note

 z The Color Swatch Utility is installed along with the printer 
drivers.

 z The results of the color test print are printed according to 
the paper settings in the printer driver, so use paper that 
allows for the largest printout.

Printing RGB Color 
Samples

1 Prints color samples.

(1) Perform the following operation to 
start up the Color Swatch Utility: 
[Start] > [Oki Data] > [Color 
Swatch Utility].

(2) Click [Print].

(3) Select this printer.

(4) Click [OK] or [Print].
This prints a three-page color sample.

(Sample)
Color 

block

Color 

values

R:255
G:203
B:220

Memo

 z The RGB values below each color block show 
the component quantity (0 to 255) of R (red), G 
(green), B (blue) in the block.

(5) Find the color in the color sample 
that you want to print, and make a 
note of its RGB values.

Memo

 z If you cannot find the color you want in the 
color sample, perform the procedure below to 
customize the color sample manually.

(6) Click [Switch] to switch to the 
custom color sample.

(7) Click [Detail] to display [Edit 
Custom Color Swatch] dialog box.

(8) Adjust the positions of the three 
bars until the desired color is 
shown on the monitor screen, and 
then click [Close].

 z Hue: Changes the hue. 0 displays red, while a 
higher value moves on the color wheel towards 
green.

Increase

0

 z Saturation: Changes the vividness. A higher 
value increases vividness, while a lower value 
makes the color more cloudy (gray).

Saturation 100

Saturation 0

 z Brightness: Changes the density. Maximum 
(100%) brightness is white, while minimum (0%) 
brightness is black.

Brightness 0 　　　Brightness 100

(9) Click [Print].

(10) Select this printer. 
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(11) Click [OK] or [Print]. 
This causes a single page to be printed 
by the printer.

(12) If you cannot find the color you 
want in the color sample, repeat 
steps (6) through (11) of this 
procedure.

2 Use the application to print the desired 
color.

(1) Open the file to be printed.

(2) Use the application to select text 
or graphics, and change the RGB 
values to those of the color sample 
block that is the color you want.

Note

 z For information about how to specify colors 
with an application, see the application's user 
documentation.

(3) Print.

Note

 z When printing a desired color from an application, use the 
same printer driver settings as those that were used when 
printing the color sample.
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 Status Monitor
Status Monitor is a utility for showing the status of the printer on a computer.

Status Monitor has the following features.

 z Indicates the status of the equipment.

 z Acquires information in the reports below as CSV files.

 - Configuration

 - Error Log

 - Color Profile List

 - User Media List 

Operating Environment
Computer running the Japanese version of Windows 10/Windows 8.1/Windows 8/Windows 7/Windows 
Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 
2008

Note

 z PC administrator privileges are required to do the setup.

 z The printer must be connected to the computer, the printer driver must be installed, and [Ports] in the printer driver must be 
set to USB or standard TCP/IP port beforehand.

Starting Up

1 Select [Start] > [Okidata] > [OKI 
Pro1040_1050 Status Monitor] to start 
up Status Monitor.

Memo

 z Another way to start the utility is to do a printing 
operation, which causes an automatic startup.

Displaying the Printer 
Status

1 Check the screenshot below.

Displays the name 
of the printer being 
monitored.

The printer’s conditions 
are described in text.

Together with the 
field above, the 
printer’s conditions 
are described in text. 
(Only appears when 
connected by USB.)

All of the conditions 
that are currently 
occurring in the printer 
are described in text.

Memo

 z The display may differ depending on the display 
mode.
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Changing the Display Mode
Status Monitor has multiple display modes that 
you can change.

 � Icon display

1 Click the [Preferences] tab in the 
advanced display screen.

2 Select [Display icon only] under 
[Minimized View].

Memo

 z [Display icon only] is selected as the initial default.

3 Click [-] in the title bar.

4 The icon appears on the taskbar.

Memo

 z Place the mouse cursor over the icon to display the 
status of the printer in a tooltip.

 �Advanced display

1 Double-click the Status Monitor icon on 
the taskbar.

2 The screen switches to the advanced 
display screen.
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 �Status panel display

1 Click the [Preferences] tab in the 
advanced display screen.

2 Select [Display Status Panel] under 
[Minimized View].

3 Click [-] in the title bar.

4 The screen switches to the status panel 
display.

Switching Printers

1 Click the [Printer Setup] tab in the 
advanced display screen.

2 Click [Select Printer].

3 After selecting the printer you want to 
change to, click [OK].

Memo

 z You can switch to printers that are compatible with 
the operating environments registered in [Devices 
and Printers].
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Acquiring Information in 
Reports as CSV Files

1 Click the [Printer Setup] tab in the 
advanced display screen.

2 Select the report data that you want to 
save as a CSV file.

3 Click [Open Configuration], specify a 
file name and a location to save the file, 
and then click [Save].

4 The CSV file is saved in the specified 
location.
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Exiting

1 Right click the icons on the title bar or 
the taskbar.

2 When a menu appears, click [Exit].

Note

 z If Status Monitor is running on a USB connection 
and another OKI utility is using the same USB 
connection, the following message appears and 
Status Monitor closes itself.

Status Monitor closes itself to avoid 
generating USB communications 
simultaneously to the same printer, but 
this is not a malfunction.

Uninstalling the Utility

1 Click [Start] > [Windows System] 
> [Control Panel] > [Programs and 
Features].

2 Select [OKI Pro1040_1050 Status 
Monitor], and then click [Uninstall].

3 Follow the instructions on the screen to 
uninstall.
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